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Preface

Manual Information

Purpose
This manual details the features, installation, operation, maintenance, 
and specifications of the NEO XHD-3903 HDTV conversion platform.

Audience
This manual is written for engineers, technicians, and operators 
responsible for the installation, setup, maintenance, and operation of the 
XHD-3903 HDTV conversion platform.

Revision History

Table P-1. Revision History of Manual

Edition Date Revision History
1st preliminary October 2007 Product improvements

2nd preliminary February 2008 Product improvements

A March 2008 Product improvements

B August 2008 Addition of fast-switching and 3G HD-SDI

C December 2008 Addition of Neural audio products, BrandNet, and logo capabilities

D July 2009 Additional Neural audio products, Dolby decoder, and second frame 
sync

E April 2010 ARC and GPI improvements; additional Dolby options
XHD-3903 Installation and Operation Manual ix
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Writing Conventions
To enhance your understanding, the authors of this manual have 
adhered to the following text conventions:

Table P-2. Writing Conventions

Term or 
Convention Description

Bold Indicates dialog boxes, property sheets, fields, buttons, 
check boxes, list boxes, combo boxes, menus, submenus, 
windows, lists, and selection names

Italics Indicates E-mail addresses, the names of books or 
publications, and the first instances of new terms and 
specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such as 
ENTER, TAB, CTRL, ALT, or DELETE

Code Indicates variables or command-line entries, such as a 
DOS entry or something you type into a field

> Indicates the direction of navigation through a hierarchy 
of menus and windows

hyperlink Indicates a jump to another location within the electronic 
document or elsewhere

Internet address Indicates a jump to a Web site or URL

Note
Indicates important information that helps to avoid and 
troubleshoot problems
x XHD-3903 Installation and Operation Manual
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Unpacking/Shipping Information
Unpacking a Product

This product was carefully inspected, tested, and calibrated before 
shipment to ensure years of stable and trouble-free service. 
1. Check equipment for any visible damage that may have occurred 

during transit. 
2. Confirm that you have received all items listed on the packing list. 
3. Contact your dealer if any item on the packing list is missing.
4. Contact the carrier if any item is damaged.
5. Remove all packaging material from the product and its associated 

components before you install the unit.
Keep at least one set of original packaging, in the event that you need to 
return a product for servicing. 

Product Servicing
Except for firmware upgrades, NEO modules are not designed for field 
service. All hardware upgrades, modifications, or repairs require you to 
return your module to the Customer Service center.

Returning a Product
In the unlikely event that your product fails to operate properly, please 
contact Customer Service to obtain a Return Authorization (RA) 
number, then send the unit back for servicing. 
Keep at least one set of original packaging in the event that a product 
needs to be returned for service. If the original package is not available, 
you can supply your own packaging as long as it meets the following 
criteria:
• The packaging must be able to withstand the product’s weight.
• The product must be held rigid within the packaging.
• There must be at least 2 in. (5 cm) of space between the product and 

the container.
• The corners of the product must be protected.
Ship products back to us for servicing prepaid and, if possible, in the 
original packaging material. If the product is still within the warranty 
period, we will return the product prepaid after servicing.
XHD-3903 Installation and Operation Manual xi
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Standards
Product compliance and safety standards for this module are contained 
in the NEO Safety Instructions and Precautions Manual (contained in 
the FR-3901, FR-3903, and FR-3923 Mounting Frames Installation 
and Operation Manual.

Restriction on Hazardous Substances (RoHS) Compliance
Directive 2002/95/EC—commonly known as the European Union (EU) 
Restriction on Hazardous Substances (RoHS)—sets limits on the use of 
certain substances found in electrical and electronic equipment. The 
intent of this legislation is to reduce the amount of hazardous chemicals 
that may leach out of landfill sites or otherwise contaminate the 
environment during end-of-life recycling. The Directive took effect on 
July 1, 2006, and it refers to the following hazardous substances: 
• Lead (Pb)
• Mercury (Hg)
• Cadmium (Cd)
• Hexavalent Chromium (Cr-V1)
• Polybrominated Biphenyls (PBB)
• Polybrominated Diphenyl Ethers (PBDE)
According to this EU Directive, all products sold in the European Union 
are fully RoHS-compliant and “lead-free.” (See our website for more 
information.) Spare parts supplied for the repair and upgrade of 
equipment sold before July 1, 2006 are exempt from the legislation. 
Equipment that complies with the EU directive is marked with a 
RoHS-compliant emblem, as shown in Figure 1.

Figure P-1. RoHS Compliance Emblem
xii XHD-3903 Installation and Operation Manual
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Waste from Electrical and Electronic Equipment 
(WEEE) Compliance

The European Union (EU) Directive 2002/96/EC on Waste from 
Electrical and Electronic Equipment (WEEE) deals with the collection, 
treatment, recovery, and recycling of electrical and electronic waste 
products. The objective of the WEEE Directive is to assign the 
responsibility for the disposal of associated hazardous waste to either 
the producers or users of these products. Effective August 13, 2005, 
producers or users are required to recycle electrical and electronic 
equipment at end of its useful life, and may not dispose of the 
equipment in landfills or by using other unapproved methods. (Some 
EU member states may have different deadlines.)
In accordance with this EU Directive, companies selling electric or 
electronic devices in the EU will affix labels indicating that such 
products must be properly recycled. (See our website for more 
information.) Contact your local sales representative for information on 
returning these products for recycling. Equipment that complies with 
the EU directive is marked with a WEEE-compliant emblem, as shown 
in Figure 2.

Figure P-2. WEEE Compliance Emblem
XHD-3903 Installation and Operation Manual xiii
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Safety
Carefully review all safety precautions to avoid injury and prevent damage 
to this product or any products connected to it. You will find a complete list 
of safety precautions in the NEO Safety Instructions and Precautions 
Manual. Only qualified personnel should perform service procedures.

Safety Terms and Symbols in This Manual
WARNING
Statements identifying conditions or practices that may result 
in personal injury or loss of life. High voltage is present.

CAUTION
Statements identifying conditions or practices that can result 
in damage to the equipment or other property.
xiv XHD-3903 Installation and Operation Manual



  
Chapter 1

Introduction

Overview
The XHD-3903 platform offers broadcast-quality HD/SD-SDI 
upconversion, crossconversion, and downconversion with aspect ratio 
conversion (ARC), and closed-captioning support. 
This chapter covers the following topics:

• “Product Description” on page 2
• “Main Features” on page 2
• “Front Modules” on page 5
• “Back Modules” on page 6
• “Breakout Cables” on page 8
• “Signal Flow” on page 13
• “Applications” on page 14

For information about NEO frames, see the FR-3901, FR-3903, and 
FR-3923 Installation and Operation Manual. The frame manual 
includes information about these items: 
• General information about module unpacking, installation, 

removal, navigation, configuration, and setup
• Card-edge screen savers
• State recovery parameters
• Fan, resource, and alarm interconnect modules
• Power supplies
• Servicing instructions
XHD-3903 Installation and Operation Manual 1
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Product Description
The XHD-3903 platform offers a wide range of different HDTV 
conversion capabilities (up, cross, down, and ARC) in AES and 
non-AES versions, along with many specialty options (including 
I-Wings, DVB teletext closed captioning, and 3 Gb/sec processing).
You can control XHD-3903 modules at the card edge with on-screen 
display, and by using CCS-enabled control panels and software 
applications such as CCS NavigatorTM.
The different versions are named as follows:
• XHD-3903-A (non-AES SD-SDI ARC)
• XHD-3903-D (non-AES downconversion)
• XHD-3903-UC (non-AES up- and crossconversion)
• XHD-3903-UCD (non-AES up-, cross-, and downconversion)
• XHD-3903-A-AES (SD-SDI ARC with AES)
• XHD-3903-D-AES (downconversion with AES)
• XHD-3903-UC-AES (up- and crossconversion with AES)
• XHD-3903-UCDAES (up-, cross-, and downconversion with AES)

Main Features
The following list includes the main features of the XHD-3903 
platform: 
• Available 3.0 Gb/sec, 1080p, 50/59.94 processing option
• Motion-adaptive de-interlacing up/cross/down conversion
• Support for wide range of HDTV formats
• Internally-generated external ARC key channel 
• Auto-detectable/user-selectable input/output standards and formats
• Error monitoring on all SDI inputs and AES inputs
• Analog composite genlock input with support for tri- and bi-level 

sync, and user-selectable internal 75Ω load termination
• Switchable external or backplane genlock inputs
• GPI inputs for triggering ARC changes; GPI outputs for signalling 

when ARC changes occur
• DARS input
2 XHD-3903 Installation and Operation Manual
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• Dedicated SD/HD-SDI output carrying the same program signal 
with embedded audio; one additional SD/HD-SDI output carrying 
either the same program signal or the same key signal 
(user-selectable)

• Automatic reconfiguration between standard conversion modes 
based on input standard changes

• Audio tracking and delay capabilities
• 10-bit motion-adaptive video de-interlacing with edge interpolation
• User-selectable detail enhancement settings (edge sharpening/

softening) 
• EIA-608, EIA-708 closed captioning transcoding capability
• Color-space conversion between SD and HD
• User-configurable aspect ratio conversion (H/V size, H/V position) 

for picture resizing, with selectable internally-generated color ARC 
backgrounds

• Automatic 2:2/3:2 pull-down detection and handling
• Ancillary data (ANC) processing 
• Adjustable vertical blanking size in fields 1 and 2; transfer and 

transcoding of closed captioning information between formats
• DVB subtitling software text option, providing ITU-R BT-653-3 

compliance (Systems A, B, C, D World System Teletext)
• Enhanced VI, WSS, and AFD decoding, processing, and encoding 

capabilities
• 24-bit audio processing
• Embedded audio processing (demultiplexing from SDI, delay/sync, 

sample rate conversion, quiet switching, and re-multiplexing into 
SDI)

• Transparent handling of embedded compressed audio with fixed 
delay

• Available eight-channel AES audio support 
• Support for compressed and linear PCM in the same audio group
• Audio sync/delay
• Support for four groups (sixteen channels) of embedded audio
• Balanced or unbalanced AES input and output (XHD-3903 AES 

versions)
XHD-3903 Installation and Operation Manual 3
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• Eight AES input channels (XHD-3903 AES versions)
• Available eight-channel AES audio support (XHD-3903 AES 

versions)
• Eight AES processed output channels (XHD-3903 AES versions)
• Loss-of-video freeze 
• Built-in SD- and HD-SDI test generator containing 75% color bars, 

cross hatch pattern, frequency sweep (luma and chroma), white, 
black, and safe area generator (SAG)

• Key output of picture or non-picture area 
• On-screen display of module parameters (see page 97 for details)
• Fast-switching capability for HD-SDI master control and 

production switching 
• DTS Neural and Dolby advanced audio processing options
• 3 Gb/s Level A and Level B (dual link SMPTE372) support (data 

and audio embed/de-embed is fixed on link A)
• Frame sync output on SDI 2
• Audio metadata embedding and de-embedding
• Audio metadata serial port receiving and transmitting
• Serial port AFD control
• Fully configurable AFD/VI/WSS embedding on AFD loss
4 XHD-3903 Installation and Operation Manual



 Chapter 1: Introduction

  
Front Modules
Figure 1-1 illustrates the position of the LEDs and card-edge controls 
on an XHD-3903-FM front module.

Figure 1-1. Card-Edge Controls on XHD-3903 Front Modules
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Power 
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Module
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Escape button

Nav+/Nav-
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Enter button
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Back Modules
Non-AES versions of the XHD-3903 use a single-slot back module 
(Figure 1-2 below); AES versions use a dual-slot back module 
(Figure 1-3). AES versions of the XHD-3903 front module cannot be 
inserted into a single slot. However, the dual-slot back module can be 
used for both front modules.

Figure 1-2. Non-AES XHD-3903-BM-1 Back Module

Figure 1-3. AES XHD-3903-BM-2 Back Module 

Figure 1-4 and Table 1-1 on page 7 show the pinouts of the back 
module DB-62 connector.

Figure 1-4. Back Module DB-62 Pinouts
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Table 1-1. Back Module DB-62 Pinouts

Pin Number Description Pin Number Description
1 GPI In 4 32 DARS In Ground
2 GPI In 3 33 AES 8 In Ground
3 GPI In 2 34 AES 7 In Ground
4 GPI In 1 35 AES 5 In Ground
5 AES 5 Out + 36 AES 6 In -
6 AES 5 Out - 37 AES 3 In Ground
7 AES 3 Out + 38 AES 4 In -
8 AES 3 Out - 39 AES 2 In Ground
9 AES 1 Out + 40 AES 1 In Ground
10 AES 1 Out - 41 RS-422 Rx + (RS-232 Rx)
11 DARS In - 42 RS-422 Tx - (RS-232 Tx)
12 AES 8 In - 43 GPI Out 4
13 AES 7 In - 44 GPI Out 3
14 AES 5 In - 45 BNC In 
15 AES 6 In Ground 46 AES 8 Out -
16 AES 3 In - 47 AES 7 Out -
17 AES 4 In Ground 48 AES 6 Out -
18 AES 2 In - 49 AES 4 Out -
19 AES 1 In - 50 AES 2 Out -
20 RS-422 Rx - 51 Aux Tx - (Aux Tx)
21 RS-422 Tx + 52 Aux Rx -
22 GPI Out 2 53 DARS In +
23 GPI Out 1 54 AES 8 In +
24 BNC In Ground 55 AES 7 In +
25 AES 8 Out + 56 AES 5 In +
26 AES 7 Out + 57 AES 6 In +
27 AES 6 Out + 58 AES 3 In +
28 AES 4 Out + 59 AES 4 In +
29 AES 2 Out + 60 AES 2 In +
30 Aux Tx + 61 AES 1 In +
31 Aux Rx + (Aux Rx) 62 Ground
XHD-3903 Installation and Operation Manual 7
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Breakout Cables
One of the following breakout cables is standard with each XHD-3903 
module:
• Non-AES cable (Figure 1-6 on page 10)
• Unbalanced 8-channel AES* cable (XHD39OPTCAB-C) 

(Figure 1-7 on page 11)

The following breakout cable is available as an option:
• Balanced 8-channel AES* cable (XHD39OPTCAB-B) for discrete 

audio versions of the module (Figure 1-8 on page 12)

Figure 1-5 on page 9 shows the numbering of the pins on the breakout 
cable DB-9 connectors.
Table 1-2 on page 9 lists the connector pinouts of the three DB-9 
connectors in each breakout cable.

CAUTION

To prevent breakage of the back module, you must support a 
balanced breakout cable. Do not allow the weight of the cable to 
rest on the back module.

The XHD-3903-UG-AESC upgrade kit makes it possible for you to 
upgrade an existing single-slot non-AES XHD-3903 module to a 
double-slot AES-compatible module. See page 34 for details.

*or 16-channel mono
8 XHD-3903 Installation and Operation Manual
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Figure 1-5. Breakout Cable DB-9 Pin Numbering

Table 1-2. DB-9 Pinouts

DB-9 Connector Pin 
Number Function

• Auxiliary data (for audio 
metadata)

• RS-232/RS-422 (for serial 
control)

2 Tx - (Tx)

3 Rx + (Rx)

7 Tx + 

8 Rx - 

Metal body Ground

GPI in/out 1 In 1

2 In 2

4 In 3

5 In 4

6 Out 1

7 Out 2

8 Out 3

9 Out 4

Metal body Ground

Pin 6 Pin 9

Pin 1 Pin 5
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Figure 1-6. Non-AES Breakout Cable
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Figure 1-7. Unbalanced AES Breakout Cable (XHD39OPTCAB-C)
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Figure 1-8. Balanced AES Breakout Cable (XHD39OPTCAB-B)

White (BK, RD)

White (BK, PU)

White (BK, OR)

White (WH, RD)

White (WH, PU)

White (WH, OR)

White (BR, PU)

White (PU, OR)

White (BK, WH)

Grey (BK, RD, GN, YL)

Black (BK, RD, GN, YL, BL, WH, OR, PU)

Black (BK, RD, GN, YL)

AUX DATA

GPI IN/OUT

RS-232/RS-422

AES 1 IN

AES 6 IN

AES 5 IN

AES 4 IN

AES 3 IN

AES 2 IN

DARS IN

AES 8 IN

AES 7 IN

Female
XLR

Male
XLR

Female
DB-9

Female
BNC

Blue (BK, WH)

Blue (BK, RD)

Blue (BK, PU)

Blue (BK, OR)

Blue (WH, RD)

Blue (WH, PU)

Blue (WH, OR)

Blue (GR, PU)

NOT IN USE

AES 1 OUT

AES 6 OUT

AES 5 OUT

AES 4 OUT

AES 3 OUT

AES 2 OUT

AES 8 OUT

AES 7 OUT

White (WH, SHIELD)
12 XHD-3903 Installation and Operation Manual



 Chapter 1: Introduction

  
Signal Flow

Figure 1-9. Signal Flow
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Applications
XHD-3903 conversion modules are suitable for the following 
applications:
• Final conversion to a high- or standard-definition output, regardless 

of input format
• Bridging between high-definition and standard-definition 

installations in a mixed signal facility
• Bridging between 720p and 1080p high-definition installations
• Transitioning small market broadcasters requiring high-quality 

conversion
• Ingestion of high-definition or standard-definition signal into a 

facility running either video standard
• Insertion of external content into the sidebars of a converted 4:3 

SDI signal, using the optional I-Wings content insertion feature
In all applications, the XHD-3903 is configured in a routing mode 
(page 15) an I-Wings mode (page 15), or a fast-switching mode 
(page 16). 
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Routing Mode
The most common application for the XHD-3903 is the routing mode, in 
which the incoming signal is converted up, down, across, or in ARC. In the 
event of a loss of video, only the actively routed signal will trigger an LOV 
event, and only one of the two SDI inputs is alarmed. This mode is 
activated when either SDI 1 or SDI 2 is selected in the Primary Video 
Source parameter (Video > Output > Primary Video Source).

Figure 1-10. Routing Mode

I-Wings Mode
The I-Wings mode displays video or graphics on the two “wings” on either 
side of an SDI signal located within a larger aspect ratio signal.
In the I-Wings mode, a loss of either SDI input will trigger an alarm. In 
addition, if video is lost on the SDI 2 input, an LOV black signal is 
automatically activated on that input. This mode is activated when you 
select SDI 1-IW in the Primary Video Source parameter (Video > 
Output > Primary Video Source). 
For more information about I-Wings, see page 63.

Figure 1-11. I-Wings Mode
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XHD-3903 Installation and Operation Manual 15



  
 Chapter 1: Introduction
Fast-Switching Mode
When an XHD-3903 module is used to provide HD-SDI sources to a 
switcher, you can set the module to one of the fast switching options in 
the Primary Video Source parameter. In the fast-switching mode, (see 
Figure 1-12) the module upconverts between SD-SDI and HD-SDI 
inputs in as little as eight frames. To achieve this response time, each 
XHD-3903’s input standard must be fixed ahead of time, and the SD/
HD sources must have the same frame rate. 
For more information about this feature, see page 65.

Figure 1-12. Fast-Switching Mode
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Level A and Level B 3 Gb/s
There are two methods for organizing video, audio, data, and metadata 
for a 3 Gb/s serial digital signal: Level A and Level B.
Level A follows the same data organization as 1080i and 720p 1.5 Gb.s 
serial digital signals. The video is carried in two streams: Stream A and 
Stream B. Stream A contains the luminance information with its VANC 
(Vertical Ancillary data space) and HANC (Horizontal Ancillary data 
space) and Stream B contains the Cb/Cr color difference signals with its 
VANC and HANC. 
Since the inception of digital television in the early '90s, broadcasters 
have used the YCbCr color space. The sampling structure is 4:2:2 
where the luminance (4) is sampled twice as often as the color 
difference (2:2). A 10-bit digital word is used when sampling the signal. 
The only difference is that 1080i and 720p take up 1.5 Gb/s when in the 
serial digital domain; 1080p takes up 3 Gb/s in the serial digital domain 
because it has twice the data (it is progressive, not interlaced).
Figure 1-13 shows the two stream data organization for 3 Gb/s 1080p 
Level A.

Figure 1-13. 3 Gb/s 1080p Level A

1080p
Stream A

Stream B

3 Gb/s

Y

CbCr

4

2:2

Frame 
Rate

Bit 
Depth

A

Serial
Data
Rate

Color
Space

Sampling
StructureLevel

10 bit
50
or
59.94

Stream
XHD-3903 Installation and Operation Manual 17



  
 Chapter 1: Introduction
Level B supports the SMPTE 372M Dual Link standard (2 x 1.5 Gb/s) 
over one 3 Gb/s serial digital connection. Dual Link has been used in 
production for many years for many video formats. Link A is formatted 
in a similar way to 1.5 Gb/s (with streams A and B). Link B adds 
formatting that is similar to the Level A signal, creating a total of four 
streams in a Dual Link Level B signal, each with its own VANC and 
HANC. The XHD-3903 currently supports the YCbCr, 4:2:2 10-bit 
standard. 
Figure 1-14 shows the dual link data organization for 3 Gb/s 1080p 
Level B.

NOTE

When the output is 3 Gb/s Dual Link, the embedded line numbers 
for closed captioning and AFD will reference the picture standard. 
For example, the output and embedding on line 20 refer to Link A 
line 10.

Figure 1-14. 3 Gb/s 1080p Level B
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Chapter 2

Installation

Overview
Installation, navigation, configuration, and setup information is 
included in the NEO FR-3901, FR-3903, and FR-3923 Mounting 
Frames Installation and Operation Manual. See our website for this 
and other related documents.
In this chapter, you will find information on the following topics:
• “Checking the Packing List” on page 20
• “Installing XHD-3903 Modules” on page 20
• “Removing XHD-3903 Modules” on page 20
• “Setting Jumpers” on page 21
• “Powering Up a Module” on page 22
• “Upgrading License Keys” on page 24
• “Upgrading Module Software using CCS 4.1 (or later)” on page 28
• “AES and 3G Upgrade Kits” on page 34
• “Advanced Audio Processing” on page 37
• “BrandNet” on page 37
• “Graphics Storage and Playout” on page 38

CAUTION

Before installation, please read the NEO Safety Instructions and 
Precautions Manual. This document contains important information 
about the safe installation and operation of NEO products.
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Checking the Packing List
The XHD-3903 packages include these items:
• One XHD-3903-FM front module, with pre-entered license keys
• One XHD-3903-BM-1 single-height non-AES back module, or one 

XHD-3903-BM-2 double-height AES back module
• One non-AES breakout cable or one AES breakout cable 
• One (optional) XHD39OPTCAB-B balanced AES breakout cable
• One XHD-3903 HDTV Conversion Platform Installation and 

Operation Manual per order

NOTE

ARC conversion is included with most versions. XHD-3903-A and 
XHD-3903-A-AES modules include an SD-SDI ARC license.

Installing XHD-3903 Modules
To configure XHD-3903 modules for use, you must first ensure that the 
module jumpers are properly set (see page 21 for details). After jumpers 
are set, you can install XHD-3903 modules into your frame using the 
standard procedures described in the NEO FR-3901, FR-3903, and 
FR-3923 Mounting Frames Installation and Operation Manual. 
AES and 3G upgrades require special installation procedures. See the 
information on page 24 and page 25.

Removing XHD-3903 Modules
These modules require no specialized removal procedures, and they are 
both hot-swappable and hot-pluggable. See page 99 for special 
information about DejaView on XHD-3903 modules. For general 
information about removing NEO modules, see your NEO FR-3901, 
FR-3903, and FR-3923 Mounting Frames Installation and Operation 
Manual. 
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Setting Jumpers
Figure 2-1 shows the placement and settings of the jumpers for AES, 
DARS, and video reference on the XHD-3903 front module. The AES 
and DARS jumpers will have different balanced or unbalanced settings, 
depending upon which breakout cable you use. On each jumper, pin 1 is 
identified by a white triangle.

Figure 2-1. XHD-3903 AES, DARS, and Reference Jumpers

J6: AES 8 out
J7: AES 7 out

J8: AES 6 out
J9: AES 5 out
J10: AES 4 out

J12: AES 1 out
J13: AES 2 out
J14: AES 3 out

J15: AES 8 in
J16: AES 7 in
J17: DARS in

J18: AES 6 in
J19: AES 5 in
J20: AES 4 in

J21: AES 1 in
J22: AES 2 in
J23: AES 3 in

J4 and J5: Reference
• Pins 1 and 2 = not currently functional
• Pins 2 and 3 = external BNC

• Pins 1 and 2 = 
balanced

• Pins 2 and 3 = 
unbalanced
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Powering Up a Module
The XHD-3903 powering-up sequence is slightly different than it is for 
other NEO modules. To power up the XHD-3903, follow these steps:

Video Settings
1. If you need on-screen display of the module’s parameters, do either 

of the following:
• Hold down the Escape button for five seconds
• In CCS, select Video > Output > Other > On Screen 

Display > (toggle Off/On).
The on-screen display appears in the SDI 2 output.

2. Select the frame rate of the output video by following Video > 
Output > Global Frame Rate.
• Auto, 25/50 Hz detects the input frame rate and offers a 

corresponding output, but in the event of no signal, outputs a 
25/50 signal.

• Auto, 29/59 Hz (default) detects the input frame rate and offers 
a corresponding output, but in the event of no signal, outputs a 
29/59 signal.

• 25/50 always outputs a 25/50 signal, but when an incompatible 
input signal is detected, the input signal is treated as 
loss-of-video.

• 29/59 always outputs a 29/59 signal, but when an incompatible 
input signal is detected, the input signal is treated as 
loss-of-video.

NOTE

Auto-detection is not available in the fast-switching mode.

3. Set the output signal standard in the Output Video Standard 
Select parameter (Video > Output > Output Video Standard 
Select).

4. Connect the input video signal to the SDI In 1 and/or SDI In 2 
connection on the back module.

5. Select your source option in the Primary Video Source parameter 
(Video > Output).
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6. If you are using frame synchronization, connect a reference signal 
to the REF input connector on the back module.

7. In the Reference Source parameter (Reference > Reference 
Source), select External Sync.

Audio Settings
1. Select Balanced or Unbalanced AES input (Audio > Input > AES 

Balanced/Unbalanced Select).
2. In the input Routing parameter (Audio > Input > Routing), select 

AES or embedded audio for SRCs 1 to 16.
3. In the output Routing parameter (Audio > Output > Routing), set 

SRCs 1 to 16 to embedded (Mux Group) or AES outputs.
4. Set the audio reference by selecting Reference > DARS Source.

The default Auto setting gives priority to video sync over DARS. If 
you wish to use DARS as your reference source, you must select 
DARS instead of Auto.
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Upgrading License Keys
By purchasing a software license key option, you can upgrade your 
XHD-3903 to a number of different capabilities. (HD/SD-SDI ARC is 
included in most of the converters; “-A” and “-A-AES” versions 
provide SD-SDI ARC.)
To upgrade a single-slot non-AES module to 3G HD-SDI capability, 
you must first install the XHD39OPT-DH upgrade kit (supplied free of 
charge) before activating the license key. See page 34 for details.
To upgrade a single-slot non-AES module to AES capability, you must 
purchase and install the XHD3903-UG-AESC hardware upgrade kit.

NOTE

If you have an existing Rev 2 double-slot XHD-3903 module, you 
must select Dual Slot in Other > Module Type Set when activating 
the license key. See “3G HD-SDI Settings” on page 78 for details.

Table 2-1 on page 25 shows all of the available software key options. In 
the parameter list, see Other > License Key and Other > License Key 
Status.
When you order a new license key, Harris Sales staff will ask you to 
provide the serial number of the module. Follow Other > Serial 
Number to obtain this information. Do not use any numbers found on 
stickers on the module itself.

Installing Advanced Audio License Keys
Follow these steps to install an advanced audio license key (Dolby or 
DTS Neural):
1. Enter the license key in the Other > License Key field, and then 

press Enter on your keyboard.
2. Wait 30 seconds for the change to take effect.
3. Reboot the module by removing it from the frame or by starting the 

reboot procedure in CCS Navigator.
The module may take a moment before it is enabled for use.

4. Confirm the license key type by rolling over the Other > Options 
field. 
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Table 2-1. Software Key Options 

New Module Type Current Module Type Upgrade Keys 
Needed

XHD-3903-UCD
and 
XHD-3903-UCDAES
Up-, Cross-, and Downconverter

XHD-3903-A 
and 
XHD-3903-A-AES
SD-SDI Aspect Ratio Converter

X3903-A-UG-UCD 

XHD-3903-D 
and 
XHD-3903-D-AES
Downconverter

X3903-D-UG-UCD

XHD-3903-UC 
and
XHD-3903-UC-AES
Upconverter and Crossconverter

X3903-UC-UG-UCD

Internal Wings (-IW) for
XHD-3903-A, -D, -UC, -UCD
and 
XHD-3903-A-AES, -D-AES, -UC-AES, -UCDAES

XHD-3903-A, -D, -UC, -UCD and 
XHD-3903-A-AES, -D-AES, 
-UC-AES, -UCDAES

XHD3903-OPT-IW

DVB Teletext Closed Captioning (in 625-SDI 
Conversion) for XHD-3903-A, -D, -UC, -UCD
and
XHD-3903-A-AES, -D-AES, -UC-AES, -UCDAES

XHD-3903-A, -D, -UC, -UCD and 
XHD-3903-A-AES, -D-AES, 
-UC-AES, -UCDAES

XHD3903-OPT-TT

Single-channel 3 Gb/sec processing 
for XHD-3903-A, -D, -UC, and -UCD*

* This feature requires the XHD39OPT-DH hardware kit, 
available at no charge. Single-slot modules must be upgraded to 
a double-height back module with the hardware kit before the 
software keys are applied.

XHD-3903-D
Downconverter

XHD39OPT-D-3G**

XHD-3903-UC
Upconverter and Crossconverter

XHD39OPT-UC-3G**

XHD-3903-UCD
Up-, Cross-, and Downconverter

XHD39OPT-UCD-3G**

Single-channel 3 Gb/sec processing 
for XHD-3903-A-AES, -D-AES, -UC-AES, -UCDAES

XHD-3903-D-AES
Downconverter

XHD39OPT-D-3G

XHD-3903-UC-AES
Upconverter and Crossconverter

XHD39OPT-UC-3G

XHD-3903-UCDAES
Up-, Cross-, and Downconverter

XHD39OPT-UCD-3G

Integrated Graphics Storage and Playout for 
XHD-3903-A, -D, -UC, -UCD
XHD-3903-A-AES, -D-AES, -UC-AES, -UCDAES

XHD-3903-A, -D, -UC, -UCD
or
XHD-3903-A-AES, -D-AES, 
-UC-AES, -UCDAES 
All Converters 

XHD3903-OPT-GFX
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BrandNet capability Any XHD-3903 module XHD3903-OPT-BN

DTS Neural Surround™ DownMix DTV 5.1 Transport 
Solution, plug-in for NEO XHD-3903 (AES input/output 
version required; for field upgrade, order 
XHD3903-UG-AESC)

Any AES-enabled XHD-3903 module XHD39OPT-DM

DTS Neural Surround™ DownMix DTV 5.1 Transport 
Solution with NLC Neural Loudness Control, plug-in for 
NEO XHD-3903 (AES input/output version required; for 
field upgrade, order XHD3903-UG-AESC)

XHD39OPT-DM-LC

DTS Neural Loudness Control for 2.0 or 5.1 Program 
Audio, plug-in for NEO XHD-3903 (AES input/output 
version required; for field upgrade, order 
XHD3903-UG-AESC)

XHD39OPT-LC

DTS Neural Loudness Control for 2.0 and 5.1 (separate 
programs), plug-in for NEO XHD-3903 (AES input/
output version required; for field upgrade, order 
XHD3903-UG-AESC)

XHD39OPT-LC-6+2

DTS Neural Loudness Control for 4 x 2.0 Program 
Audio, plug-in for NEO XHD-3903 (AES input/output 
version required; for field upgrade, order 
XHD3903-UG-AESC)

XHD39OPT-LC-8

DTS Neural Loudness Control for 5.1 Program Audio 
with Neural DTS-Surround™ Downmix output, plug-in 
for NEO XHD-3903 (AES input/output version required; 
for field upgrade, order XHD3903-UG-AESC) 

XHD39OPT-LC+DM

DTS Neural Surround™ 5.1 and rendered stereo content 
transitioning for DTV 5.1 Production, plug-in for NEO 
XHD-3903 (AES input/output version required; for field 
upgrade, order XHD3903-UG-AESC)

XHD39OPT-MM

DTS Neural Surround™ 5.1 and rendered stereo content 
transitioning for DTV 5.1 Production with NLC Neural 
Loudness Control, plug-in for NEO XHD-3903 (AES 
input/output version required; for field upgrade, order 
XHD3903-UG-AESC)

XHD39OPT-MM-LC

DTS Neural Surround™ UpMix DTV 5.1 Production 
Solution, plug-in for NEO XHD-3903 (AES input/output 
version required; for field upgrade, order 
XHD3903-UG-AESC)

XHD39OPT-UM

Table 2-1. Software Key Options (Continued)

New Module Type Current Module Type Upgrade Keys 
Needed
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DTS Neural Surround™ UpMix DTV 5.1 Production 
Solution with NLC Neural Loudness Control, plug-in for 
NEO XHD-3903 (AES input/output version required; for 
field upgrade, order XHD3903-UG-AESC)

Any AES-enabled XHD-3903 module XHD39OPT-UM-LC

Dolby E and AC-3 Decoder Option Hardware and 
Software Key (AES input/output version required; for 
field upgrade, order XHD3903-UG-AESC)

XHD3903OPT-D1

Dolby E Integrated Encoder Hardware and Software Key 
(AES input/output version required; for field upgrade, 
order XHD3903-UG-AESC)

XHD3903OPT-D2

Dolby Digital (AC-3) Integrated Encoder Hardware and 
Software Key (AES input/output version required; for 
field upgrade, order XHD3903-UG-AESC)

XHD3903OPT-D3

Second channel SD/HD frame sync (no HD Up/Down/
Cross conversion)

XHD39OPT-2FS

**Must be ordered with the free XHD39OPT-DH Double-Height hardware kit

Table 2-1. Software Key Options (Continued)

New Module Type Current Module Type Upgrade Keys 
Needed
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Upgrading Module Software 
using CCS 4.1 (or later)

NOTE

Starting with CCS version 3.5, Pilot and CoPilot are no longer 
offered as separate programs. A free trial version of CCS Navigator 
is packaged with each new XHD-3903 order; after the trial period, 
the program retains the upgrading capability of the former CoPilot 
program. 

To monitor and control XHD-3903 modules using CCS Navigator, 
you must first upgrade your NEO frame resource module software 
to version 4.0 or higher. In addition, firmware upgrades to the 
XHD-3903 module require the use of Navigator 4.2 or higher.

XHD-3903 modules with Neural audio options have a slightly 
different behavior during and after a software upgrade. See 
page 34 for details.

Overview
Software upgrading is a routine procedure that you must perform to 
install newer versions of software on XHD-3903 modules. CCS 
Navigator software application is required for this procedure. Use care 
to ensure that you upload the correct files to the intended module.
In the unlikely event that the upgrade fails, the module may not respond 
to controls and will appear to be non-functional. In that event, follow 
the procedures described in “Correcting a Failed Upgrading Procedure” 
on page 31.
Before beginning the upgrading procedure, ensure that you have written 
down the IP address of your module. To do this, select the Build mode 
in CCS software. Right-click on the module, select Properties, and 
then click Device. The IP address appears in the second Device ID 
field.
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Upgrading Procedure
The upgrading procedure will take approximately 10 minutes. Follow 
these steps to upgrade the software:
1. Download the most recent upgrade package for your module from 

our website.
2. Set your CCS Pilot or Navigator software to the Build mode 

(CoPilot only functions in Build mode).
3. If the affected module has not been discovered, perform the 

Discovery operation, as described in your CCS software 
application manual or online help, and then save the results. 

4. From the Tools menu, select Software Upgrade. 
The Software Upgrade window opens or is brought to the 
foreground (see Figure 2-2).

Figure 2-2. Software Upgrade Tool’s New Transfer Tab

5. On the New Transfer tab, click Add.
The Device Selection dialog opens.

6. Select one or more devices, and then click OK to close the Add 
Device dialog box.
Here is some additional information:

Click here to access 
these options:
• Entering Telnet 
• Entering FTP user 

name and password
• Creating automatic 

backups

Package Info includes a 
list of the components 
contained in the .ZIP file 
(.ZIP file must appear in 
the field first) 
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• You can only add one unit from each IP address. Since all 
items in a frame have the same IP address, you cannot 
upgrade multiple modules in the same frame at the same 
time.

• The selected devices appear in the table on the New 
Transfer tab of the Software Upgrade window. This table 
lists devices that are to receive the same upgrade package. 

• You can highlight the position of each device in the 
Navigation pane by clicking Find Device. 

• The Version Info and Device Options... buttons currently 
are not supported by the XHD-3903.

7. In the Software Upgrade window, press Browse... to select the 
software upgrade package (ZIP file) that you want to upload to the 
module. 
A standard Windows File Selection dialog box opens. 

8. Choose the upgrade ZIP file on a local or network drive, and then 
click Open. 
The selected file’s path name is displayed beside the Browse… 
button.

9. Click Submit Transfer... 
A dialog box opens, requesting confirmation that you want to 
proceed with the request. If you have multiple devices selected, 
multiple transfer tasks are submitted—one per device.
The extraction process on the ZIP file is handled as part of the 
upgrade process. You do not need to extract the files yourself. 
Although the file name disappears from the screen, the transfer is 
now underway. You may close the Software Upgrade window, 
continue with other tasks, or switch to the Progress tab to view the 
status of the transfers. The transfer may take several moments.

NOTE

Closing the Software Upgrade window does not affect any of the 
transfer processes that may be running in the background. If you try 
to log off or exit the CCS software while a transfer is underway, a 
notification window will alert you that processes are still active and 
will ask if you want to terminate these processes.
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10. Click on the Log tab and look at the Transfer Status column to 
ensure that all files have correctly updated. 
The module is automatically rebooted after the upgrade procedure.

CAUTION

After the transfer is complete, the module reboots and upgrades 
itself for approximately five minutes. Do not interrupt this event. 
When the module is ready, the card-edge Status LEDs lights green, 
and in CCS Navigator, the status is Network Active.

11. To confirm the correct software version was installed, right-click 
the module in the Navigation pane, select Configuration, then 
Version, and then Software.

Correcting a Failed Upgrading Procedure
Software upgrades may fail in the event of network interruptions, power 
failures, or if too much data is uploaded to the XHD-3903 module. 
The failure can be corrected by re-installing the software while in a 
fail-safe mode, as described in the following pages. Use care to ensure 
that you upload the correct files to the intended module.
Two general steps are involved in correcting a failed upgrade. These 
steps are found in the following sections: 
1. “Setting the Module to Fail-Safe Loader Mode” (below)
2. “Upgrading the Software in the Boot Folder in Fail-Safe Mode” on 

page 32

Setting the Module to Fail-Safe Loader Mode
Follow these steps to set the module to the fail-safe loader mode:
1. Remove the affected module from the NEO frame.
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2. Press the Nav switch down while simultaneously pressing the 
Escape button.

Figure 2-3. Buttons on a Typical Card Edge

3. While still pressing the button and the navigation switch, reinsert 
the module into the frame and hold for approximately three seconds 
until the Status LED begins “chasing.”
If your device has been discovered, you can continue upgrading 
your device’s software, starting with step 4 on page 29. If the 
device has not been discovered, continue with the procedure 
described below.

Upgrading the Software in the Boot Folder in Fail-Safe Mode
This is the second stage of the failed upgrading procedure. To 
successfully complete this upgrade, you must follow these steps in the 
exact sequence described:
1. Enter Build mode in CCS Pilot or Navigator.
2. In the Navigation pane, drag or copy-and-paste the module’s device 

icon from the Catalog folder into your NEO frame.
3. Right-click the device icon, and then select Properties.
4. On the Device tab of the Navigation Properties box, enter the IP 

address of the frame that holds the module (see below). 

Enter 
button

Nav 
switch

Escape 
button
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Figure 2-4. Navigation Properties Box

5. In the third field, enter 
1.0.[slotnumber]

(For example, 1.0.5 would refer to the module in slot 5 of the 
frame.) 

NOTE

Ensure you do not make changes in the last field (located above 
and to the right of the Set Default button.) The value for the 
XHD-3903 module will be 5.154.

6. Close the window, and continue upgrading your device’s software, 
starting with step 4 on page 29.

Do not make changes in 
this field

Enter the frame IP 
address here

Always set to 1 Always set to 0
for NEO 
products

Insert slot number:

-1 to 12 for regular modules
-17 or 18 for resource modules
-0 for a NEO frame
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Upgrading Modules with DTS Neural Audio
With a Neural audio submodule installed, the XHD-3903 behaves 
slightly differently during software upgrades.
After the usual CCS upgrade, additional components must be upgraded 
as well. During this time, two or four lit LEDs at the card edge scroll 
left and right across the module. This may take two minutes. When the 
LEDs have finished cycling, and the Status LED is green, the upgrade is 
complete.
When the module is in failsafe mode, three LEDs scroll left and right 
across the module.
The XHD-3903 module must be turned off and re-powered to apply the 
changes from the upgrade. 

AES and 3G Upgrade Kits
The XHD3903-UG-AESC optional upgrade kit makes it possible for 
you to upgrade an existing single-slot non-AES module to a double-slot 
AES-compatible module. 
The XHD39OPT-DH upgrade kit (available free of charge) makes it 
possible to upgrade a single-slot non-AES module to 3G HD-SDI 
capability when you purchase a 3G license key. This hardware kit must 
be installed before you activate the license key.
The upgrade packages include the following items:
• Unbalanced AES breakout cable (XHD3903-UG-AESC only)
• Double-slot back module
• Power connector assembly with mounting screws
• Standoff with mounting screw

Installation Procedure
Follow these steps to install the upgrade kit:

1. Remove the XHD-3903 front module, back module, and breakout 
cable from the NEO frame.

2. Replace the existing single-slot back module with the new 
double-slot AES version.
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3. If applicable, connect and tighten the new unbalanced AES 
breakout cable (XHD39OPTCAB-C), or the optional balanced AES 
breakout cable (XHD39OPTCAB-B).
The balanced breakout cable requires extra support. See page 36 
for details.

4. Attach the power connector assembly to the XHD-3903 front 
module by gently tightening the two mounting screws from 
underneath the module (Figure 2-5).

5. Mount the 1-inch (2.5 cm) metal standoff in the left corner of the 
module by gently tightening the supplied screw from underneath 
the module.
This standoff prevents the accidental insertion of a module into the 
upper slot.

6. Reinsert the modified front module into the frame.
7. Install the software license key (XHD39OPT-DH only).

Figure 2-5. Installation of the Upgrade Kit

Power connector 
assembly
with mounting screws

Double-slot back 
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with mounting 
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Balanced Breakout Cable Support
When using the balanced AES breakout cable, you must provide 
support to prevent damage to the back module. The FR-3901-RSB 
(1RU) and FR-3923-RSB (3RU) cable support bars are available for 
this purpose (Figure 2-6). Instructions for installing the support bar are 
found in the NEO FR-3901, FR-3903, and FR-3923 Installation and 
Operation Manual.

Figure 2-6. Balanced Breakout Cable Support (3RU Version 
Shown)

Tie wrap

Horizontal support barBreakout cable
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Advanced Audio Processing
The XHD-3903 offers a wide variety of DTS Neural and Dolby audio 
processing options. These options make it possible to offer advanced 
audio processing for high-definition and surround sound programming 
using 5.1 and stereo sources.
To install one of the advanced audio options, your XHD-3903 module 
must be configured for AES capability. This may require the installation 
of the XHD3903-UG-AESC upgrade kit. See page 115 for complete 
information about DTS Neural and Dolby audio options.

NOTE

Only one DTS Neural Audio option or one Dolby option can be 
installed on an XHD-3903 at any given time.

BrandNet
BrandNet is an ABC (USA) Network protocol used for the carriage of 
triggers in the VANC of an HDTV signal. The XHD3903-OPT-BN 
softkey option makes it possible for the XHD-3903 to preserve the 
BrandNet SDR (Single Data Rate) Satmatte and DDR (Double Data 
Rate) Sal Matte data during up-, cross-, and downconversion. The 
XHD3903-OPT-BN option also passes MasterKey legacy triggers for 
HDTV. 
The BrandNet DID, BrandNet SDID, and read-only BrandNet 
Present parameters are found in the Input > De-Embed path. The 
output signal is enabled using the BrandNet Embed parameter 
(Output > Embedder). BrandNet is supported only in 525 and 720p/
59.94 formats.
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Graphics Storage and Playout
When you order the XHD3903-OPT-GFX Integrated Graphics Storage 
and Playout option with the XHD-3903, two additional hardware items 
are enclosed:
• 1 GB microSD memory card and SD-to-microSD adapter
• MicroSD-to-USB adapter
The microSD memory card and adapter kit make it possible to transport 
graphics from your PC to any XHD-3903 module (these items must be 
provided by the customer when the option is ordered separately).
Use the LogoCreator software provided on the IconTools CD-ROM to 
position and convert your on-air graphics files to the mg2 format. Then 
transfer the files from your PC’s USB port to the microSD card—using 
the adapter kit provided—and insert the microSD card into the socket 
located on the underside of your XHD-3903 module (see Figure 3). 

Figure 3. Inserting the MicroSD Card

The XHD3903-OPT-GFX software license key must be installed on the 
XHD-3903 module to download your graphics files. See “Integrated 
Graphics Storage and Playout” on page 87 for more information about 
converting graphics files using LogoCreator.

MicroSD card in socket
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Chapter 3

Audio and Video Configuration

Overview
This chapter describes the audio and video configuration options that 
can be changed in the course of normal operation.
The following topics are found in this chapter:
• “Audio Configuration” on page 40
• “Aspect Ratio Processing” on page 46
• “Active Format Description” on page 51
• “I-Wings Integrated Sidebar Content Insertion” on page 63
• “Closed Captioning and DVB Teletext Captioning” on page 72
• “GPI Inputs and Outputs” on page 74
• “Video Keying” on page 78
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Audio Configuration
All XHD-3903 modules process embedded audio. The input embedded 
audio from SDI 1 is demultiplexed (de-embedded) and synchronized to 
the video, delayed to match the video processing delay, processed, and 
then remultiplexed (re-embedded) into HD- and SD-SDI video output. 
Up to four groups of audio can be embedded into the video stream.
The AES versions of the XHD-3903 can process both embedded audio 
and discrete AES audio. Unlike embedded audio, discrete AES audio 
flows independently from the video stream. This audio is synchronized 
to the video, delayed to match the video processing delay, processed, 
and then multiplexed into HD- and SD-SDI output. The audio can also 
be output as a discrete AES signal.

Audio Controls
XHD-3903 modules can route audio from one of several sources to the 
outgoing SDI (up to 8 channel pairs can be embedded) and/or AES 
outputs (1 channel pair each). 
The non-AES XHD-3903 modules support embedded audio. These 
modules are capable of demultiplexing up to four groups of embedded 
audio from the primary video SDI stream, and embedding up to four 
groups into the output SDI stream. The discrete AES versions 
additionally provide eight AES inputs (each balanced or coax) and eight 
AES outputs (each balanced or coax). XHD-3903 modules can select up 
to eight channel pairs of audio without AES, and an additional eight 
pairs of channels with AES.
The Demux Group Present and Demux Channel Pairs Present 
parameters (Audio > Input > Status > Demux Group Present and 
Demux Channel Pairs Present) indicate which groups and channel 
pairs have audio present in the video inputs.
The AES Present parameter indicates whether AES audio is detected.
See page 43 for more information about audio status parameters.
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Audio Routing
Input

To manually configure the audio inputs, you will need to select options 
in the Audio > Input > Routing section. Set your options in the SRC1 
to SRC8 Input Select parameters (for non-AES modules), or the SRC1 
to SRC16 Input Select parameters (for AES modules). 
The default settings for non-AES inputs follow this pattern:
• SRC1 Input Select = SDI 1 Group 1 Channel 1/2
• SRC2 Input Select = SDI 1 Group 1 Channel 3/4
• SRC3 Input Select = SDI 1 Group 2 Channel 1/2
• SRC4 Input Select = SDI 1 Group 2 Channel 3/4, etc.

The default settings for AES inputs follow this pattern:
• SRC9 Input Select = AES1a/1b
• SRC10 Input Select = AES2a/2b
• SRC11 Input Select = AES3a/3b
• SRC12 Input Select = AES4a/4b, etc.

Output
To manually configure the output of the audio, select Enable in Mux 
Group 1 Enable to Mux Group 4 Enable. (This is found at Audio > 
Output > Embedder > Mux Group 1 Enable to Mux Group 4 
Enable.) 
Next, set your options in the Routing section (Audio > Output > 
Routing > Mux Group x Channel x).
The default audio routing settings follow this pattern: 
• Mux Group 1 Channel 1 = SRC 1A
• Mux Group 1 Channel 2 = SRC 1B
• Mux Group 2 Channel 1 = SRC 2A
• Mux Group 2 Channel 2 = SRC 2B, etc.
In addition to selecting audio sources from the video groups, four 
custom tone generators are available, as well as Mute and SMPTE 
RP155 and EBU R68 tones. To set the four custom tones, follow the 
path to Audio > Other > Tones > Tone Generators 1 to 4 Level.
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Figure 3-1. Audio Routing

Audio Proc Amp
Gain, bypass, and delay controls are available for the left and right side 
of each of the processed audio channels.
You can individually adjust the gain and delay of the left and right sides 
of each channel using the control parameters in the Gain and Delay 
sections (Audio > Processing > Gain or Delay).
The audio can contain non-PCM audio data (in other words, it is 
indicated by bit 1 of channel status bits being set for Non-Audio 
instead of Audio as shown on page 112). In this case, the sample rate 
converter must be bypassed to ensure audio integrity. You must 
individually indicate which sample rate converter or gain to bypass 
using the SRCx Gain/Bypass parameters (Audio > Input > Bypass > 
SRCx Gain/Bypass). Select Manual in the SRC/Gain Bypass Mode 
to enable these individual controls. 
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If you set SRC/Gain Bypass Mode to Auto, the audio will be 
monitored, and if non-PCM audio data is detected, the sample rate 
converter for that side of the channel will be bypassed.
In addition to the mute controls that control audio pairs individually, a 
Master Mute control mutes all of the audio channel pairs (Audio > 
Processing > Gain > Master Mute). Also, if the audio source for either 
side of a given audio channel does not have any incoming audio, the 
signal will be automatically muted. 

Dolby and DTS Neural Audio Processing
For configuration information about Dolby and DTS Neural audio 
options, see page 115.

Audio Status Parameters
The read-only Demux Group Present parameter (in Audio > Input > 
Status) indicates which groups are present in the video input (see 
Figure 3-2). The “=” indicates no audio is detected for a particular 
group, while the letter P indicates the presence of audio. For example, 
“= P= =” means the XHD-3903 detects audio in Group 2, but no audio 
is detected in the other three groups.

Figure 3-2. Demux Group Present and Demux Group Error

The Demux Group Error parameter (also in the Audio > Input > 
Status path) displays errors in the same way. In a string of “=” signs, 
the letter E indicates an error for that audio group.
Demux Channel Pair Present displays the eight channel pairs, with 
the letter P indicating audio presence (see Figure 3-3).

====

Group 1
Group 2
Group 3
Group 4

P
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Figure 3-3. Demux Channel Pair Present/Type, and AES Present

Demux Channel Pair Type displays the eight channel pairs, with the 
letter A indicating PCM audio, and the letter D indicating non-PCM 
(data). In AES Present, the letter P indicates the presence of AES. In 
AES Channel Pair Type, A = PCM; D = non-PCM (data).

Audio V-Fade
To enable a smooth de-embedded audio V-fade transition while 
switching between same-standard video sources, set the Audio V-Fade 
parameter to Enable. 
To have “glitch-free” audio output when you use the audio processing 
module, or when the user delay is set to different values for different 
channels, you can adjust the V-Fade Mute Time, V-Fade Time, and 
HD Inter-Group Phase parameters.
When the V-Fade Mute time is changed to less than 0.2 seconds, or the 
fade time is changed to less than 0.5 seconds, the HD Inter-Group 
Phase must be disabled to avoid an output audio glitch.

========

Channel Pair 1, Group 1 
Channel Pair 2, Group 1 
Channel Pair 1, Group 2 
Channel Pair 2, Group 2 

Channel Pair 2, Group 4
Channel Pair 1, Group 4
Channel Pair 2, Group 3
Channel Pair 1, Group 3
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DARS Sources
The DARS Source parameter (Reference> DARS Source) aligns the 
AES output signal with one of the following options:
• Auto

When set to this option, the module automatically selects the 
method for aligning with the AES output signal. DARS Present 
and DARS Locked parameters provide feedback.

• Video (external reference signal) 
The X/Z preamble of the output AES signal aligns with the 
reference signal as per AES11-1997 and RP 168-2002.

• DARS 
The Z preamble of the output AES signal aligns with the Z 
preamble of DARS.

• Off (nothing)
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Aspect Ratio Processing
The XHD-3903 offers a highly configurable and comprehensive feature 
set for processing aspect ratio codes and determining ARC settings. The 
key benefits are that ARC control and AFD/WSS/VI code insertion 
control can track, but can also operate independently from each other. 
In addition, user-defined mapping makes it possible to have complete 
control over what ARC and code is inserted for any given input of AFD, 
WSS, or VI code.

Enhanced Aspect Ratio Conversion Control
GPI triggers can modify the aspect ratio conversion control for each 
mode of operation separately. In other words, you can change the ARC 
for upconversion without affecting the ARC for down- or 
crossconversion. For example, if the XHD-3903 is in upconversion 
mode, the GPI can only change the upconversion ARC setting. This 
capability makes it possible to control the ARC control for any mode, 
regardless of which mode is currently active.
A user-selectable ARC setting is provided in the event that AFD, WSS, 
or VI code disappears. For example, if upconversion is set to follow 
AFD, but the AFD data isn't available, the user can choose which ARC 
to implement in its place. 

Enhanced AFD/WSS/VI Insertion
GPI triggers can affect the insertion mode and insert specific codes for 
AFD, WSS, and VI. Each control is separate and independent from the 
other.

Enhanced Monitoring
GPI outputs on the XHD-3903 can perform the following:
• Monitor for specific input AFD, WSS, and VI codes 
• Separately monitor the ARC setting for each conversion mode 
• Report the current AFD, WSS, or VI insertion mode in use for a 

particular type of conversion
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Enhanced User ARC Settings
Each user setting includes default AFD, WSS and VI code associated 
with it. A Live View mode makes it possible to see custom ARC 
adjustments in real time.

Custom Code Map
With the custom code map, you have the ability to precisely specify the 
ARC setting and code insertion for each input AFD, WSS, and VI code, 
including reserved codes. You can override only the code insertion, the 
ARC setting, or both. In addition, you can override specific AFD, WSS, 
or VI codes and leave the remainder as default.
The map can be used to create custom AFD In to AFD Out mappings, 
as well as custom translation from any incoming AFD, WSS, and VI to 
insert any AFD, WSS, and VI code.
GPI triggers make it possible to switch between standard mapping and 
custom mapping for each conversion mode separately.

Conversion Mode
Depending on the current input/output video standard setting, the 
XHD-3903 will be placed in an up-, down-, cross-, or SD-ARC 
conversion mode. Most of the arcing settings are set per conversion 
mode. To see the immediate results of ARC settings, the related mode 
selection must be set to match the current conversion mode. If the mode 
selection is set to Current, the ARC control will always take effect 
immediately. The conversion mode settings are found in these paths:
• Video > Processing >ARC > ARC Control > Mode
• Video > Processing > ARC > AFD-VI-WSS Insertion > Mode
• Video > Processing > ARC > AFD-VI-WSS Custom Mapping > 

Mode
• Other > GPI Input > Event Mode
• Other > GPI Output > Event Mode
The current operating mode is shown in the ARC Mode Feedback 
parameter at Video > Processing > ARC > Status. 
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Aspect Ratio Conversion
For the module output, you can select either a standard ARC setting, or 
one of your own customized preset ARC settings. There are five 
customized preset ARC settings for each conversion mode. All settings 
are maintained separately for each conversion mode.

Selecting a Standard Aspect Ratio
To select a standard aspect ratio for the output image, set ARC Control 
(found at Video > Processing > ARC > ARC Control) to one of the 
following selections:
• Anamorphic
• 4:3 Pillar Box
• 14:9 Pillar Box
• 16:9 Cut
• 4:3->21:9 Ltr
• 16:9 Letter Box
• 14:9 Letter Box
• 4:3 Cut
• 16:9->21:9 Ltr
• PixelTrue
Pixel True performs no scaling to the input video. Instead, each input 
pixel is mapped directly to one output pixel. You can use this preset to 
transport an SD picture embedded inside an HD stream.

Selecting a Custom Aspect Ratio
To select a pre-defined custom aspect ratio for the output image, use 
one of the options found at Other > GPI Input > ARC Control: 
• Custom Up ARC1 to Custom Up ARC5 
• Custom Down ARC1 to Custom Down ARC5
• Custom Cross ARC1 to Custom Cross ARC5
• Custom SD ARC1 to Custom SD ARC5
Only five options are exposed at one time, based on the mode selected.
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Selecting Aspect Ratio Control Following AFD, VI, WSS
An XHD-3903 module can automatically change the aspect ratio, based 
on the incoming AFD, WSS, or VI control codes. Set the ARC Control 
parameter to one of the following selections (some options are not 
available, depending upon the selected conversion mode):
• AFD
• AFD - ALTR
• AFD - Custom Map
• VI
• VI - ALTR
• VI - Custom Map
• WSS
• WSS - ALTR
• WSS - Custom Map
The AFD, WSS, and VI selections follow standard ARC 
recommendations. For instance, selecting AFD causes the module to set 
the ARC setting according to the incoming AFD code, -ALTR 
selections use the alternate ARC method, and Custom Map follows the 
user defined ARC settings for each individual code. See “Active Format 
Description” on page 51 for more details about custom mapping.

Setting a Custom Aspect Ratio
You can scale and pan the output image to any size and location by 
using the various parameters of the custom aspect ratio settings. These 
parameters include: Horizontal Offset, Vertical Offset, Horizontal 
Scale, Vertical Scale, Crop Left, Crop Right, Crop Top, and Crop 
Bottom. These parameters can be individually modified, or 
batch-modified by recalling a standard aspect ratio or a pre-defined 
custom aspect ratio. 
Setting Live Edit View to On will actually make the custom aspect 
ratio settings take effect immediately on the output. This is useful when 
trying to visually align the various parameters.
Custom aspect ratios are configured by choosing a custom aspect ratio 
name from Save ARCs selections.
All of the related controls can be found at Video > Processing > ARC 
> Custom ARC.
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Overscan Mode
The overscan mode is similar to a zoom mode. When enabled, it 
discards a specified number of lines and columns of pixels around the 
borders of the input image active picture region before processing.
For example, the active picture region for 525 standard starts on line 20 
and ends at line 263 on field 1. Therefore, an overscan setting of one 
line implies that upconversion starts at line 22 and ends at line 261. In 
addition to the two discarded lines, the first and last pixel of each 
remaining line in the active picture region are discarded.
The overscan mode prevents data embedded in the active picture region 
(usually line 21), such as closed captioning, from being converted.
To enable the overscan mode, scroll to the Overscan Up, Overscan 
Down, Overscan Cross, or Overscan SD-ARC (Video > Processing > 
ARC), and then select the number of rows and columns for cropping. 
Using the overscan control you can also discard picture ramp-up and 
ramp-down regions commonly present in material digitized from 
analog video sources. 
If you are using an XHD-3903 with a downstream keyer, and the keyed 
image appears with a dark border around it, the border is caused by this 
shaping of the incoming video frame. Use the Overscan Up, Overscan 
Down, Overscan Cross, or Overscan SD-ARC parameters to 
minimize this border effect.
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Active Format Description
Active Format Description (AFD) transmits data in the VANC portion 
of the SDI signal, enabling both 4:3 and 16:9 television monitors to 
optimally present video with preset ARC and safe area information. 
Without AFD, converted video may appear distorted or “cut off” when 
it appears on different monitors. The XHD-3903 can encode or decode 
AFD; it can also encode or decode earlier Video Index (VI) and Wide 
Screen Signalling (WSS) formats.
In addition, the XHD-3903 provides the ability to automatically embed 
AFD in the event of the loss of an embedded input signal (Video > 
Output > Embedder > AFD Control).
You can control the AFD features using both software parameters and 
serial connectors found on breakout cables. For more information about 
serial control, see page 66.

AFD/ARC Alignment
When you use AFD to select your aspect ratio, the XHD-3903 ensures 
that the AFD codes and associated image will remain in sync. For 
example, during a hotswitch, the new ARC will only be applied to the 
new image. There are a few cases which could cause AFD/ARC 
misalignment:
• The ARC applied is reducing the image vertically such that the new 

image is less than 60% of the original image.
• The output standard is set to either 1080p/23.98 or 1080p/29.97.
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Figure 3-4 shows two comparisons of a signal that is encoded with AFD 
and without AFD. 

Figure 3-4. AFD/Non-AFD Comparisons
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Figure 3-5 shows different applications of AFD insertion and decoding.

Figure 3-5. AFD Block Diagram

The AFD feature of the XHD-3903 includes nine possible SD-SDI 
configurations and eight possible configurations in HD-SDI. Figure 3-7 
on page 57 describes the SD-SDI AFD configurations; Figure 3-8 on 
page 58 describes the HD-SDI AFD configurations. 

AFD, VI, and WSS Detection
AFD, VI, and WSS data that is embedded in the incoming video can be 
detected by the XHD-3903, and read from the following parameters 
found in the Video > Processing > ARC > Status path: 
• AFD Present
• VI Scan Present 
• VI AFD Present 
• WSS Present
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AFD, VI and WSS Code Insertion
AFD, VI and WSS data can be passed from input to output, or it can be 
generated manually or automatically by the XHD-3903 module. This 
function is controlled by the AFD Insert, VI Insert, and WSS Insert 
parameters located in the Video > Processing > ARC > AFD-VI-WSS 
Insertion path. Table 3-1 lists the function of each of the available 
options (some options are not available in all conversion modes).
You can also remove WSS from the input video stream. To do this, 
follow: Video > Input > De-embedder > Input WSS Remove.

Table 3-1. AFD, VI and WSS Code Insertion

Option Details
Pass The incoming AFD, VI or WSS code is inserted unmodified. 

(This option is only supported in SD-ARC and crossconversion modes. In up- or 
downconversion modes, the Pass option is equivalent to a loss of code, even when 
an input code is present. When a loss of code occurs, the module will insert your 
selection from the AFD Pass on Loss, VI Pass on Loss, or WSS Pass on Loss 
parameters.)

Remove No code is generated by the module. The original input code is removed, except for 
the following:
• WSS in line 23 
• All codes in proc bypass mode. 

Auto The module generates code automatically and inserts it. The code can be generated 
in one of the following scenarios:
• A standard or custom aspect ratio is selected, and the corresponding AFD, VI, or 

WSS code is inserted. 
• The ARC Control parameter is set to AFD, AFD-ALTR, VI, VI-ALTR, WSS, 

or WSS-ALTR, and the generated output code is based on input code according 
to the alternate implementations of the standard.

• The ARC Control parameter is set to AFD-Custom Map, VI-Custom Map or 
WSS - Custom Map, and the output code is generated from the custom map 
settings.

• Custom AFD Map
• Custom VI Map
• Custom WSS Map

The output code is generated according to the custom map table.

(code list) The actual code selected is inserted
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AFD, VI, WSS Based Aspect Ratio Control
When you set the ARC Control parameter to follow the aspect ratio 
codes (AFD, AFD-ALTR, AFD-Custom Map, VI, VI-ALTR, 
VI-Custom Map, WSS, WSS-ALTR, and WSS-Custom Map), the 
aspect ratio control is based on input AFD, VI, or WSS code. 
AFD-Custom Map, VI-Custom Map, and WSS-Custom Map make 
it possible for you to perform automatic aspect ratio conversions based 
on the custom defined mapping table. The other options set the ARC to 
an existing standard. When the input code is missing, the ARC behavior 
is defined by Loss of AFD ARC, Loss of VI ARC or Loss of WSS 
ARC. Only one of these options is be enabled at any one time.
Though they are not widely used, some AFD, VI or WSS codes 
recommend cropping part of the image. When this type of cropping is 
enabled, the module will take longer to change ARC modes. To create 
faster ARC transitions, you can disable the cropping using the AFD 
Crop Enable parameter (Video > Processing > ARC > ARC 
Control).
When the ARC is based on AFD, VI, or WSS, and the output standard 
is SD-SDI, you must set the output aspect ratio (either 4:3 or 16:9) to 
ensure that the correct mapping table is used. (Follow Video > 
Processing > ARC > ARC Control > SD Out Aspect Ratio.)

AFD, VI, WSS Custom Mapping Configuration
Using the controls in Video > Processing > ARC > AFD-VI-WSS 
Custom Map, you can define a special mapping table other than the 
one specified by a standard. Given any input AFD, VI or WSS code, 
you can define the aspect ratio behavior and output AFD, VI and WSS 
code independently.

Advanced Controls
The de-embedding line controls for VI and WSS are at Video > Input > 
De-embedder. The embedding line number controls for AFD, VI, and 
WSS are at Video > Output > Embedder.
If you are using VI according to the SMPTE Proposed RP-186+ 
standard as of January 11, 2007, you must ensure you have enabled the 
standard by following this path: Video > Output > Embedder > SD 
Out VI with AFD (default setting is Yes).
At this time, Bar Data and Pan-Scan for VI and AFD are not supported.
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AFD Descriptions
In the following pages, Figures 3-7 to 3-12 show the different AFD 
code descriptions. Comparable WSS and VI templates are included in 
the SD-SDI descriptions.

Figure 3-6. Explanation of AFD Diagrams

Bounding box represents
the coded frame.

The smallest rectangle enclosing
the white regions indicates the area
of essential picture information.

Black regions indicate areas
of the picture that do not
contain useful information and
should be cropped by the
receiver where appropriate.

Gray regions indicate areas of the picture
that may be cropped by the receiver
without significant loss to the viewer.
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Figure 3-7. 4:3 AFD Descriptions

AFD 4:3 code and description

Illustration in a
4:3 coded frame Description

Image with a 16:9 aspect ratio and with an
alternative 4:3 center as a vertically centered

letterbox in a 4:3 coded frame

alternative 14:9 center as a vertically centered
Image with a 16:9 aspect ratio and with an

letterbox in a 4:3 coded frame

Image with a 4:3 aspect ratio and with an
alternative 14:9 center in a 4:3 coded frame

Image with 14:9 aspect ratio as a vertically
centered letterbox in a 4:3 coded frame

Image with a 16:9 aspect ratio as a vertically
centered letterbox in a 4:3 coded frame

Image is full frame, with an aspect ratio that is
the same as the 4:3 coded frame

Image with aspect ratio greater than 16:9 as
a vertically centered letterbox in a 4:3 coded

frame

Image with a 14:9 aspect ratio as letterbox at
the top of a 4:3 coded frame

Image with a 16:9 aspect ratio as letterbox at
the top of a 4:3 coded frame

WSS name

100  
16:9 Top

010 
14:9 Top

101
GT 16:9 

000
4:3 Full

011
16:9 CNTR

001
14:9 CNTR

110
4:3 A 14:9 

Not 
applicable

Not 
applicable 

AFD and VI Select 
parameter options

(4:3) 0010
16:9 Top

(4:3) 0011
14:9 Top

(4:3) 0100
GT 16:9

(4:3)  1010
16:9 L

(4:3) 1011
14:9 L

(4:3) 1000
4:3  Full

(4:3) 1101
4:3  A 14:9 

(4:3) 1111
16:9 LA 4:3

(4:3) 1110
16:9 LA 14:9
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Figure 3-8. 16:9 AFD Descriptions

AFD 16:9 code and description

Illustration in a
16:9 coded frame

(16:9) 0100 
GT 16:9 

AFD and VI Select 
parameter options

(16:9) 1111
16:9 A 4:3

(16:9) 1011
14:9 P

(16:9) 1101
4:3 P A 14:9 

(16:9) 1110
 16:9 A 14:9

(16:9) 1000
16:9 Full

(16:9) 1010
16:9 Prtctd 

(16:9) 1001 
4:3 P

Description

Image with a 16:9 aspect ratio and with
an alternative 4:3 center in a 16:9 coded

frame

Image with a 16:9 aspect ratio and with
an alternative 14:9 center in a 16:9

coded frame

Image with a 4:3 aspect ratio and with an
alternative 14:9 center as a horizontally
centered pillarbox image in a 16:9 coded

frame

Image with a 14:9 aspect ratio as a
horizontally centered pillarbox image

in a 16:9 coded frame

Image is full frame, with a 16:9 aspect
ratio and with all image areas protected

Image with a 4:3 aspect ratio as a
horizontally centered pillarbox image

in a 16:9 coded frame

Image is full frame, with an aspect ratio
that is the same as the 16:9  coded

frame

Image with aspect ratio greater than 16:9
as a vertically centered letterbox in a

16:9 coded frame

Not 
applicable

WSS name

111
Anamorphic

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable
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Figure 3-9. 4:3 to 16:9 Conversion

4:3 to 16:9 conversion

Illustration in a
4:3 coded frame Conversion Conversion (Alternative)WSS name AFD and VI Select 

parameter options

(4:3) 0010
16:9 Top

(4:3) 0011
14:9 Top

(4:3) 0100
GT 16:9

(4:3)  1010
16:9 L

(4:3) 1011
14:9 L

(4:3) 1000
4:3  Full

(4:3) 1101
4:3  A 14:9 

(4:3) 1111
16:9 LA 4:3

(4:3) 1110
16:9 LA 14:9

100  
16:9 Top

010 
14:9 Top

101
GT 16:9 

000
4:3 Full

011
16:9 CNTR

001
14:9 CNTR

110
4:3 A 14:9 

Not 
applicable

Not 
applicable 
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Figure 3-10. 4:3 to 4:3 Conversion

4:3 to 4:3 conversion
Conversion
(Alternative)ConversionIllustration in a

4:3 coded frameWSS name AFD and VI Select 
parameter options

(4:3) 0010
16:9 Top

(4:3) 0011
14:9 Top

(4:3) 0100
GT 16:9

(4:3)  1010
16:9 L

(4:3) 1011
14:9 L

(4:3) 1000
4:3  Full

(4:3) 1101
4:3  A 14:9 

(4:3) 1111
16:9 LA 4:3

(4:3) 1110
16:9 LA 14:9

100  
16:9 Top

010 
14:9 Top

101
GT 16:9 

000
4:3 Full

011
16:9 CNTR

001
14:9 CNTR

110
4:3 A 14:9 

Not 
applicable

Not 
applicable 
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Figure 3-11. 16:9 to 4:3 Conversion

16:9 to 4:3 conversion

Illustration in a
16:9 coded frame

Conversion 
(Alternative)Conversion

(16:9) 0100 
GT 16:9 

AFD and VI Select 
parameter options

(16:9) 1111
16:9 A 4:3

(16:9) 1011
14:9 P

(16:9) 1101
4:3 P A 14:9 

(16:9) 1110
 16:9 A 14:9

(16:9) 1000
16:9 Full

(16:9) 1010
16:9 Prtctd 

(16:9) 1001 
4:3 P

Not 
applicable

WSS name

111
Anamorphic

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable
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Figure 3-12. 16:9 to 16:9 Conversion

16:9 to 16:9 conversion
Conversion 
(Alternative)ConversionIllustration in a

16:9 coded frame

(16:9) 0100 
GT 16:9 

AFD and VI Select 
parameter options

(16:9) 1111
16:9 A 4:3

(16:9) 1011
14:9 P

(16:9) 1101
4:3 P A 14:9 

(16:9) 1110
 16:9 A 14:9

(16:9) 1000
16:9 Full

(16:9) 1010
16:9 Prtctd 

(16:9) 1001 
4:3 P

Not 
applicable

WSS name

111
Anamorphic

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable

Not 
applicable
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I-Wings Integrated Sidebar Content Insertion
I-Wings integrated content insertion is a software key option that makes 
it possible to key HD- or SD-SDI content into the sidebar portion of the 
output image raster using the module’s internal keyer. This option is 
useful, for example, in applications where upconversion of SD-SDI 4:3 
content is being performed, and insertion of additional content is 
required in the 16:9 upconverted image raster's sidebars. (See 
Figure 3-13 on page 64.)
To set up the I-Wings feature, follow these steps:
1. Ensure that SDI 1 and SDI 2 inputs have compatible frame rates.

An SDI 1 Standard Mismatch or SDI 2 Standard Mismatch 
alarm is activated if the two inputs are not compatible. In that event, 
the module automatically generates a black background, replacing 
the SDI 2 input until a valid input is received.

2. Set the ARC parameters as required, found in this path: Video > 
Processing > ARC.
I-Wings will only appear in the background area. Therefore, ARC 
settings that are anamorphic will block I-Wings from appearing.

3. Select SDI 1-IW in the Primary Video Source parameter (Video > 
Output > Primary Video Source).
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Figure 3-13. Creating the I- Wings Effect

Anamorphic 16:9 sidebar contentARC-adjusted 4:3 program

Program output with I-Wings sidebar content
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Fast-Switching Capability
When XHD-3903 modules are used to provide HD-SDI sources to a 
switcher, you can set the module to one of the fast switching options in 
the Primary Video Source parameter. (Fast switching is available 
when you have purchased “–UC” or “-UCD” capability for your 
XHD-3903 module.)
In the fast-switching mode, the module transitions between SD-SDI and 
HD-SDI inputs in eight frames or less, providing ready access to 
converted HD signals for the switcher. (See Table 3-2 on page 66 for a 
list of equivalent times in milliseconds.)
To achieve this response time, each XHD-3903’s HD-SDI input 
standard must be fixed ahead of time. The module will accept one SD 
standard and a frame rate-compatible HD standard. The input 
auto-detection feature does not operate in this mode.
Follow these steps to configure the fast-switching mode:
1. In the Primary Video Source parameter (Video > Output), select 

either SDI1-FAST-SW 25/50 or SDI1-FAST-SW 29/59.
2. Select the correct input standard in Fast Switch Standard (Video > 

Output) 
3. Set the Input Frame Delay (Video > Processing > Synchronizer).

The time transition between input standard changes is shown in 
Table 3-2 on page 66 when the Input Frame Delay is set to 0. 
Increasing the Input Frame Delay results in a longer transition 
time. The value set in this parameter is added to the eight frames 
that result from the default setting of 0.

4. Connect an external reference to the module.
The module defaults to External Reference.

When the XHD-3903 is operating in the fast-switching mode, 720p and 
1080i input standards are offered (the related SD-SDI standards are 
implicit). If the module receives a standard that has not been selected, it 
treats the signal as invalid, and the module reverts to its loss-of-video 
setting (Video > Output > Primary LOV Mode). In this condition, the 
SDI1 Std Mismatch parameter reports an Unknown/invalid response 
and activates a major alarm.
In fast-switching mode, the Background Color defaults to Black; 
other colors are disabled.
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Aspect ratio settings for the HD-SDI output are preconfigured for the 
HD-SDI switcher standard. Information about setting the ARC output 
begins on page 46.

Serial Control Information
To communicate using serial control, use a hyperterminal application, 
ensuring you have enabled the echo function. (Version 1.14 firmware 
must be installed on the XHD-3903 module). Either of the standard 
breakout cables shipped with the XHD-3903 will provide the DB-9 
pinouts. Because each facility uses different configurations, connecting 
cables are not provided with the XHD-3903 package. 

NOTE

Serial control on the XHD-3903 does not support non-printing 
characters; control keys such as Backspace will not function.

Table 3-2. Minimum Transition Delay

Output Format Transition Time 
(Milliseconds)

525 266.9

720p/59 200.2

1080i/59 266.9

1080p/29 266.9

1080p/23.98 333.6

1080p/59 200.2

625 320

720p/50 240

1080i/50 320

1080p/25 320

1080p/50 240
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Figure 3-14. Breakout Cable DB-9 Pin Numbering

Table 3-3. DB-9 Pinouts

DB-9 Connector Pin Number Function
RS-232 2 Tx - (Tx)

3 Rx + (Rx)

7 Tx + 

8 Rx - 

Metal body Ground

Table 3-4. Serial Port Specifications

Item Specification
Supported Standard RS-232

Baud rate 115200

Data bits 8

Parity None

Stop bits 1

Flow control None

Pin 6 Pin 9

Pin 1 Pin 5
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Table 3-5. Serial Control Commands 

Command Comments
init The first command; must be executed before any other control command can be used. 

Upon successful execution, the XHD-3903 sends out a Connection established message.

release Releases the connection established by init command; upon successful execution, the 
XHD-3903 sends out Connection closed message.

setafdmode Controls the output AFD code.
This command should be called as setafdmode bbbb, where b is either 0 or 1, and bbbb 
in combination should represent a valid AFD code. 
Note: This control result will be reflected on the CCS control parameters AFD Control 
and AFD Select. AFD Control is set to Insert Custom, and AFD Select is set to the code 
of bbbb. The output selected for the insertion is indicated by z.

getafdmode Gets the current output AFD code. 
This command should be called as setafdmode. The card will return current AFD code in 
bbbb format if it is inserting some AFD code; it will reply Not inserting AFD code if it is 
not inserting any code. 

boardstatus Depending on the module status, the XHD-3903 will reply with one of the following:
• Major and Minor alarm on
• Major alarm on
• Minor alarm on
• Good

help Prints out all the supported commands through this port.
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enumset [CCS 
Param - 
ID],[Enum Index]

Sets an enumeration parameter on the XHD-3903.

Arguments
• CCS Param - ID is the parameter ID specified in the XHD-3903 Parameter List, 

supplied with this document
• Enum Index is the enumeration index value for the parameter specified in the 

XHD-3903 Parameter List.

Return Value
• ok - Parameter set command successfully sent
• error - Parameter set command failed to send

Example
Here is a sample parameter definition from the XHD-3903 Parameter List:

ARC Preset DOWN [CCS-P Parameter ID = 357]
Description: Selects a preset ARC configuration.
Navigation Path:/ Video/Processing/ARC
Type: enumeration
Access: read/write
Default: 0
Enum Values: 0="Anamorphic" ,1="4:3 Pillar Box" ,2="14:9 Pillar Box" ,3="16:9 Cut" 
,4="4:3->21:9 Ltr" ,5="16:9 Letter Box" ,6="14:9 Letter Box" ,7="4:3 Cut" 
,8="16:9->21:9 Ltr" ,9="PixelTrue" ,10="Preset 1" ,11="Preset 2" ,12="Preset 3" 
,13="Preset 4" ,14="Preset 5" ,15="Preset 6" ,16="Preset 7" ,17="Preset 8" ,18="Preset 9" 
,19="Preset 10" ,20="AFD" ,21="AFD - ALTR" ,22="VI" ,23="VI - ALTR" ,24="WSS" 
,25="WSS - ALTR" ,26="Custom" 

To set the above parameter to Anamorphic using the enumset serial command, the 
following command can be issued:

enumset 357,0

A return value of ok is then returned upon the successful execution of the above command. 

Table 3-5. Serial Control Commands (Continued)

Command Comments
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intset [CCS Param 
- ID],[Integer 
value]

Sets an integer parameter on the XHD-3903.

Arguments
• CCS Param - ID is the parameter ID specified in the XHD-3903 Parameter List, 

supplied with this document
• Integer value is the integer value specified in the XHD-3903 Parameter List’s Valid 

Range (supplied with this document), and does not take precision into account. This 
number value can be preceded by a '-' to indicate a negative number. 

Return Value
• ok - Parameter set command successfully send.
• error - Parameter set command failed to send. 

Example
Here is a sample parameter definition from the XHD-3903 Parameter List:

Horz. Offset [CCS-P Parameter ID = 274]
Description: Sets the ARC horizontal offset.
Navigation Path:/ Video/Processing/ARC
Type: integer
Access: read/write
Valid Range:- 800 to 800 with units of % and precision of 1 decimal places
Default: 0

To set the above parameter to -25.5% using the intset serial command, the following 
command can be issued:

intset 274,-255

A return value of ok is then returned upon the successful execution of the above command.

Table 3-5. Serial Control Commands (Continued)

Command Comments
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strset [CCS Param 
- ID],[String 
value]

Sets a string parameter on the XHD-3903.

Arguments
• CCS Param - ID is the parameter ID specified in the XHD-3903 Parameter List, 

supplied with this document
• String value is an ASCII character string value of the parameter. The character string 

must be preceded and terminated by a '"' character. String value can not exceed 64 
characters.

Return Value
• ok - Parameter set command successfully send.
• error - Parameter set command failed to send. 

Example
Here is a sample parameter definition from the XHD-3903 Parameter List:

File Path Select [CCS-P Parameter ID = 440]
Description: Selects the logo image to load.
Navigation Path:/ Video/Processing/Logo
Type: string
Access: read/write
Default: 

To set the above parameter to logo1.mg2 using the strset serial command, the following 
command can be issued:

strset 440, "logo1.mg2"

A return value of ok is then returned upon the successful execution of the above command.

Table 3-5. Serial Control Commands (Continued)

Command Comments
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Closed Captioning and DVB Teletext Captioning
Although North America has dedicated standards for closed captioning 
of video (EIA-608 and 708), many countries in Europe and elsewhere 
have not yet adopted formal standards. For these countries, closed 
captioning is part of the DVB Teletext System as described in ITU-R 
BT-653-3. These specifications define all Teletext Systems (Systems A, 
B, C, D) used in the world and are also known as the World System 
Teletext (WST).  A Teletext system is made of several pages of various 
data information and CC data is described in one these pages. System B 
is used in Australia, the UK, and Germany, among other countries.
Australian closed captions are inserted on line 21/334 in analog PAL 
broadcast signals, as per the ITU-R BT-653-3. When analog PAL is 
produced or converted to SDTV (625 digital), a digitized version of the 
closed captioning appears on line 21/334 (in the same way line 21 on 
NTSC signals is digitized and appears on the line 21 of SD-SDI 
signals). The ITU-R BT-653-3 document proposed by Free TV 
Australia indicates how to carry this CC data into the VANC area of 
SD-and HD-SDI signals by use of the SMPTE 334M VANC embedding 
protocol. For digital broadcasting, Australia intends to use the ETSI EN 
300 472 standard that specifies the conveyance of ITU-R System B 
Teletext in DVB bit streams.

Setting Closed Captioning and Teletext
To make changes to the default CC and Teletext settings, use the Closed 
Captioning/Teletext Embed and Closed Captioning/Teletext Embed 
Line parameters from the path Video > Output > Embedder path. To 
verify the presence of the embedded CC, use the Input Closed 
Captioning/Teletext Present parameter (Video > Input > 
De-embedder path).
The DVB Teletext feature is available when you purchase the 
XHD3903-OPT-TT software key option. See page 24 for more 
information.
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Generic VANC Data Passing
The XHD-3903 can pass user-defined VANC packets. These VANC 
data packets are identified by their DID/SDID. Controls for Data DID, 
Data SDID, Data Pass, and Data Embed Field are located at Video > 
Output > Embedder. Currently, the XHD-3903 supports one unique 
combination of DID/SDID packets to pass from HD-SDI standard input 
to HD-SDI standard output

Examples
• To pass NBC Namedropper, make the following settings:

• Data DID to 52
• Data SDID to 0F
• Data Pass to Pass
• Data Embed Field to 1st Field
• Data Embed Line to 11

• To pass CBS Lidia data, make the following settings:
• Data DID to 54
• Data SDID to 22
• Data Pass to Pass
• Data Embed Field to 1st Field
• Data Embed Line to 9
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GPI Inputs and Outputs
The XHD-3903 module provides four GPI inputs and four GPI outputs 
for automation. These are open collector style inputs with 
approximately 10 KΩ pull-ups to +5V. This means that you can use 
contact closure-to-ground switches to control these GPI inputs.
The GPI input actions are controlled by parameters in Video > Other > 
GPI Input.
GPI inputs make it possible to control the ARC being used for a 
particular conversion mode, as well as the AFD, WSS or VI code to be 
inserted. The read-only GPI Input Status parameter provides current 
information. All GPI events occur in the order they are triggered and 
will override older events.
The GPI output actions are controlled in the Video > Other > GPI 
Output path.
GPI outputs can reflect the state of the current ARC being used, or can 
be triggered on a specific input AFD, WSS or VI code. 
The current GPI output active status can be read from the GPO Output 
Status parameter.

Custom GPI Events
The Custom GPI feature on the XHD-3903 makes it possible for you to 
configure GPIs so that certain combinations of GPI input levels can 
change a parameter to a specific value. The GPI output state can be 
determined by changes to certain parameter values.
To set up custom GPIs, the related GPI event selections have to be set to 
Custom GPI at:
    Other > GPI Input > Event
    Other > GPI Output > Event
In addition, you must write a custom GPI script and enter it into the 
follow parameters:
    Other > Custom GPI > Custom Input Script
    Other > Custom GPI > Custom Output Script
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NOTE

When you select a Custom GPI input or output, the GPI Trigger 
control is disabled for that specific GPI. Also, the GPI Input Status 
and GPI Output Status parameters will not report the portion of the 
the field that represents custom GPIs.

Writing the Custom GPI Script
GPI input scripts and GPI output scripts are created from several 
statements. Each statement consists of one condition and several 
assignments:

IF [condition] THEN [assignment] [assignment] ...

In each statement, if the condition is satisfied, the assignments will take 
effect. A condition is created from one or more comparisons.
In a GPI input script, the comparison could be either GPIx == 0 or 
GPIx == 1, where x is in the range of [0, number of GPI inputs - 1], and 
0 represents low and 1 represents high.

In a GPI output script, the comparison is in the format of 
PARAM[x]==y, where x is the ID of a device parameter and y is a value 
for that parameter.

The script can include any of the following comparisons:
• ==  equal
• >   greater than
• <   less than
• >=  greater or equal than
• <=  less than or equal than
• !=  not equal

Comparisons can be ANDed together using &&, and then can be ORed 
together using || to form a condition. The AND operation always has 
precedence over the OR operation when AND and OR both exist in a 
condition.
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GPI Input and Output Examples
The following GPI input script condition 

GPI2==1 || GPI0==0 && GPI1==1 || GPI0==1
should be interpreted as 

GPI2==1 || (GPI0==0 && GPI1==1) || GPI0==1

And the following GPI output script condition
PARAM[400]==5 || PARAM[400]==3 || PARAM[400] >= 8 && 
PARAM[400] <= 12

should be interpreted as 
PARAM[400]==5 || PARAM[400]==3 || (PARAM[400] >= 8 && 
PARAM[400] <= 12)

    

The assignment is always done using the = symbol
In a GPI input script, an assignment is written as PARAM[x]=y, where 
x is the ID of a device parameter and y is a value for that parameter.
In a GPI output script, an assignment is written as GPOx==0 or 
GPOy==1, where x and y is in the range [0, number of GPI outputs -1] 
and 0 represents low and 1 represents high.

GPI In Example
IF GPI0==0 && GPI1==0 THEN PARAM[755]=2
IF GPI0==0 && GPI1==1 THEN PARAM[755]=3
IF GPI0==1 && GPI1==0 THEN PARAM[755]=10
IF GPI0==1 && GPI1==1 THEN PARAM[755]=19 

In the above example, if the level of GPI input 0 and GPI input 1 match 
an entry in the following table, the parameter with 755 as its ID will be 
assigned to the corresponding value:
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GPI Output Example
IF PARAM[754]==2 THEN GPO0=0 GPO1=1
IF PARAM[754]==3 THEN GPO0=1 GPO1=0
IF PARAM[754]==7 THEN GPO0=1 GPO1=1
IF PARAM[754]<2 || PARAM[754] > 3 && PARAM[754]<7 
THEN GPO0=0 GPO1=0 

In the above example, if the parameter with 754 as its ID has a current 
value that matches one of the entries in the following table, the levels of 
GPI output 0 and GPI output 1 level will be assigned to the 
corresponding values: 

The maximum length of a script is 500 characters.

Table 3-6. GPI Input Parameter Example

GPI Input 0 GPI Input 1 Value of Parameter 
with ID of 755 

Low Low 2

Low High 3

High Low 10

High High 19

Table 3-7. GPI Output Parameter Example

Value of Parameter 
with ID of 754 GPI Output 0 GPI Output 1

0 Low Low

1 Low Low

2 Low High

3 High Low

4 Low Low

5 Low Low

6 Low Low

7 High High
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Video Keying
The video keying feature is activated by following Video > Output > 
Config > Video Keying. When enabled, the key image appears on the 
SDI 2 output. The On Screen Display feature (Video > Output > 
Config > On Screen Display) also appears on the SDI 2 output when it 
is enabled.

3G HD-SDI Settings
If your module is a Rev 2 version, you must select Dual Slot in Other 
> Module Type Set to activate the 3G capability. To confirm your 
version, check the module identification number as shown in 
Figure 3-15. If your module is Rev (2), you will need to select the Dual 
Slot option.
When you changing the Module Type Set parameter to Dual Slot, you 
must wait 30 seconds, and then re-power the module.

CAUTION

If your module is Rev A, do not change the Module Type Set 
parameter. If your module is Rev 2, do not change Module Type 
Set to Dual Slot if the card does not have an AES or 3 G upgrade 
kit installed. The module may be damaged if you do not follow 
these steps.

Figure 3-15. Module Version Number

Module 
version 
number
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Operation

Overview
Installation, navigation, configuration, and setup information is 
included in the NEO FR-3901, FR-3903, and FR-3923 Mounting 
Frames Installation and Operation Manual. You can access this and 
other related documents by visiting our website.
This chapter describes how to operate the XHD-3903 modules using 
card-edge controls and CCS-enabled devices and software.

NOTE

To monitor and control XHD-3903 modules using CCS Navigator, 
you must first upgrade your NEO frame resource module software 
to version 4.0 or higher. In addition, firmware upgrades to the 
XHD-3903 module require the use of Navigator 4.2.

The following topics are found in this chapter:
• “Selecting the Conversion Mode” on page 80
• “Cross-Functional Parameter Changes” on page 81
• “Operation Notes” on page 82
• “Video Synchronization and Delay” on page 83
• “Audio Synchronization and Delay” on page 86
• “Integrated Graphics Storage and Playout” on page 87
• “Navigating the Parameter List” on page 97
• “Alarms” on page 98
• “Unique State Recovery Behavior” on page 99
• “LEDs and Module Indicators” on page 100
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Selecting the Conversion Mode
Each module of the XHD-3903 series includes the same core feature 
set, including closed captioning transcoding, and transparent handling 
of four groups of embedded audio. Table 4-1 lists the input and output 
standards of the different XHD-3903 variations.

Table 4-1. Conversion Modes 

Converters Input Output
XHD-3903-A Standard 
Definition Aspect Ratio 
Converter

SD-SDI
• 525i
• 625i 

SD-SDI
• 525i (from 525i)
• 625i (from 625i)

XHD-3903-D 
Downconverter

HD-SDI
• 1080i
• 720p 
• 1080p
• 1080psf

SD-SDI
• 525i
• 625i

XHD-3903-UC Up- and 
Crossconverter

SD-SDI
• 525i
• 625i 

HD-SDI 
• 1080i
• 720p 
• 1080p
• 1080psf

HD-SDI
• 1080i
• 720p
• 1080p

XHD-3903-UCD, Up-, 
Cross-, and 
Downconverter

SD-SDI
• 525i
• 625i 

HD-SDI 
• 1080i
• 720p 
• 1080p
• 1080psf

SD-SDI
• 525i
• 625i

HD-SDI
• 1080i
• 720p
• 1080p
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Cross-Functional Parameter Changes
Each different conversion mode enables, disables, or changes the 
options that are available in the parameter lists. In some cases, the range 
of certain numeric values will be smaller, for example, between the 
upconversion and crossconversion modes. In other cases, some options 
will not be functional, or previously unavailable options will become 
visible. These changes reflect the different specifications of the various 
SD and HD-SDI standards, and are not indications of flaws in the 
control interface.
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Operation Notes

CAUTION

Failure to observe these Operation Notes will result in accidental 
changes to the module’s parameter settings.

When using the XHD-3903 modules, observe the following operation 
notes:
• If you change parameters within 16 seconds after the XHD-3903 

module starts up, your changes will not be saved. Parameter 
changes that you make after this 16-second delay will be saved if 
the module loses power. You must restart the module to restore 
these saved settings.

• Although the effect of a parameter change may appear to be 
immediate, the module requires 20 seconds to save the latest 
change. If another change is made during these 20 seconds, the first 
parameter change and the second parameter change will not be 
saved until 20 seconds after the second parameter change. There is 
no limit to the number of changes that can be made within 20 
seconds of each other. However, none of these changes will be 
saved until 20 seconds after the last parameter change.

• XHD-3903 modules have two SDI outputs. The SDI 1 output 
always carries program output. You can configure the SDI 2 output 
to carry either the same signal as the SD1 output (with or without an 
output key signal for downstream keying and on-screen display of 
parameters) or a frame sync signal. Depending on the configuration 
and availability of the input signals, the output video timing can be 
derived from input video, timing reference input, or it can be 
free-running within the tolerance allowed by the applicable 
standards. 

• Changes in some parameters will cause additional changes in other 
parameters, or lock them out entirely. See “Cross-Functional 
Parameter Changes” on page 81 for more information.
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Video Synchronization and Delay
The XHD-3903 modules provide conversion between HD- and/or 
SD-SDI standards. During conversion, there is a certain amount of 
delay added to the primary SDI input signal in the main video 
processing path. The amount of delay to the primary signal is dependent 
upon the type of processing applied to it.
In the routing mode, the selected SDI input signal is 
frame-synchronized to the genlock reference (see page 15). A user 
delay control is available to compensate for other external processes. 
The user delay interface provides a delay range between 0 to 8 frames 
in one-frame increments.
When the I-Wings feature is in use, the SDI 2 signal does not enter the 
frame synchronizer (see page 15). Therefore, the user delay interface is 
not available for the SDI 2 input. However, this signal is synchronized 
to the genlock reference inside the scalar, and thus, upstream 
synchronization of the SDI 2 signal is not required.
Additionally, an external DARS reference input (AES interface) 
provides audio timing synchronization when the module embeds the 
audio streams into the SDI program output.

Video Frame Synchronizer
Primary Frame Sync

The video frame synchronizer (frame sync) on the primary SDI input 
provides synchronization using the Reference Source parameter 
(Reference > Reference Source). The default option in this parameter 
is the External Reference sync mode. SDI input timing is provided by 
the Delay option.
When the External Reference option is selected, the frame 
synchronizer automatically detects and locks to the genlock reference 
signal for video timing alignment. The frame synchronizer either drops 
or repeats video frames to achieve synchronization.
The XHD3903 module supports the following reference signals:
• NTSC/PAL-M, TLS1080i/59, and TLS1080p/29 
• PAL-B, TLS1080i/50, and TLS1080p/25
• 720p59 (when the module’s output is 1080p59, 1080p59 Level B, 

or 720p59)
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Figure 4-1. SDI 2 Scalar Output

Secondary Frame Sync
When the XHD39OPT-2FS softkey is installed, frame sync can be 
output to the SDI 2 connector. To enable the frame sync on SDI 2, select 
Video > Output > Embedder > SDI Source > FS. This enables the 
horizontal and vertical phase adjustments that are found at: Video > 
Processing > Sync. Secondary timing control does not affect SDI 1 
output timing. The secondary frame sync only provides a Level A 
output, even if the input is Level B.

Figure 4-2. SDI 2 Frame Sync Output

Delays
The total propagation delay is the result of adding frame sync, SD user 
frame delay, the SD-ARC scalar value, and the SD user output delay. 
The values shown in Table 4-2 and Table 4-3 represent the scalar only. 
These are also the delay values through the entire product if the 
following conditions are true:
• The module is in Delay mode (Reference > Reference Source).

Video 
frame
 sync

Scalar and 
audio/ancillary 

processing
SDI in

Primary 
control timing

SDI 1 out

SDI 2 out

Video 
frame
 sync

Scalar and 
audio/ancillary 

processing
SDI in 

Primary 
control timing

SDI 1 out

Secondary 
timing control

SDI 2 out
84 XHD-3903 Installation and Operation Manual



 Chapter 4: Operation

  
• The Output Vertical Phase and Output Horizontal Phase 
controls (Video > Processing > Synchronizer) are set to 0.

• The Input Frame Delay (Video > Processing > Synchronizer) is 
set to 0 (maximum setting = 12 frames).

Using the sync mode (Reference > Reference Source > Free Run or 
External Ref) adds 0 to 1 frame to the delay.
Also see page 124 for information about propagation delays involving 
Neural audio options.

Table 4-2. Minimum Propagation Delays, 59.94 Hz

Output (ms)

Input 525 720p/59.94 1080i/59.94 1080p/23.98 1080p/29.97 1080p/59.94

525 33.4 33.4 33.4 33.4 33.4 33.4

720p/59.94 16.7 16.7 16.7 0 0 16.7

1080i/59.94 33.4 33.4 33.4 16.7 16.7 33.4

1080psf/23.98 41 41 41 41 41 41

1080p/23.98 41 41 41 41 41 41

1080p/29.97 33.4 33.4 33.4 33.4 33.4 33.4

1080p/59.94 16.7 16.7 16.7 16.7 16.7 16.7
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Audio Synchronization and Delay
Audio is synchronized to video by applying the same frame sync delay 
and converter delay to the audio associated with the given video path.
By changing the Input/Output Delay SRC x parameter (Audio > 
Other > I/O Delay Config > Input/Output Delay SRC x), you can 
turn on or off the frame sync and processing delay. This triggers the 
audio to resynchronize with the video. (The two options are FS and 
Converter Delay and None.) When enabled, the audio synchronization 
will not occur immediately. Approximately 10 seconds per frame of 
delay are needed in order to prevent any audio “glitch.”
You can add additional delay using the Delay 1 to 32 (Channels 1 to 16 
Left and Right) parameters, found in the Audio > Processing > Delay 
path.
This processing delay is always applied in addition to the audio 
synchronization and will cause an audio glitch to occur when the 
processing delay changes. 

Table 4-3. Minimum Propagation Delays, 50 Hz

Output (ms) 

Input 625 720p/50 1080i/50 1080p/25 1080p/50 

625 40 40 40 40 40

720p/50 20 20 20 0 20

1080i/50 40 40 40 20 40

1080p/25 40 40 40 40 40

1080p/50 20 20 20 20 20
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Integrated Graphics Storage and Playout
The optional XHD3903-OPT-GFX logo generator and inserter provides 
on-demand insertion of pre-defined static SD-SDI and HD-SDI logo 
images.
Logos used by the XHD-3903 must be created or saved in the .mg2 file 
format, and initially stored on a micro-SD card that is inserted into the 
slot located at the card edge of the module. (LogoCreator software is 
provided as a utility to convert existing files to .mg2). The process is 
similar to the loading of logos into an X75, with a few exceptions:
• The XHD-3903 uses a microSD card* instead of an SD card.
• The files must be loaded onto the card directly at your PC 

workstation.

Figure 4-3. Progression of Logo to On-Air Signal

The files that you use as logos must be selected according to the video 
output standard set on the XHD-3903 (Video > Output > Output 
Video Std Select). When the output standard changes on the module, 
the XHD-3903 automatically loads files that use the selected output 
standard.

* SanDisk 512 MB and 1 GB microSD cards are supported.

Logo Insertion on the XHD-3903

Existing logo 
graphic with 

alpha channel

Conversion to 
.mg2 format using 

LogoCreator

Storage of logo file 
on a microSD card 
via the USB port on 

a PC

Loading of file into 
XHD-3903 module 

for on-air use
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Basic Steps to Installing Logo Files
If you are starting with existing graphics files, these basic steps are 
described in the following pages:
1. Install the LogoCreator conversion software from the IconTools 3.0 

CD-ROM.
2. Convert the logos to an .mg2 format.
3. Transfer the files to the microSD card via CCS Pilot/Navigator, or 

directly from the PC.
4. Set the parameters and load the logo files using CCS Navigator.
5. Set your GPI parameters (optional).

Step 1: Install LogoCreator Software
All logos used by the XHD-3903 must either be generated as .mg2 files 
or converted to that format. A version of LogoCreator (located on the 
IconTools 3.0 CD-ROM) is provided with the manual for this purpose.
For best results, LogoCreator requires a PC with the following system 
specifications:
• Intel Pentium III processor at 500 MHz or faster
• 512 MB or more of physical memory (RAM)

• Microsoft® Windows® XP or Windows 2000

If a version of LogoCreator already exists on the PC, ensure that you 
first uninstall the program and restart the computer. Then proceed with 
the steps below:

1. Close all other software applications running on the PC and then 
insert the IconTools CD-ROM into the computer’s CD-ROM tray.

2. Using Windows Explorer, browse to the CD-ROM contents, and 
then double-click the LogoCreator folder.

3. Double-click Setup.exe. 
4. When the IconTools 3 Setup box appears, click Next, and then 

follow the on-screen installation instructions. 
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Step 2: Convert Files to the .mg2 Format
Using LogoCreator, you need a source image file for the fill portion of 
your logo, and a source image file for the key portion. The fill is the 
picture or image you want to overlay onto the program output. The key 
is the cutout or shape of the desired logo, which may or may not be the 
same shape as the fill. Using LogoCreator, you will set the fill and key 
images to the same size (resolution) as the standard of the XHD-3903 
output. LogoCreator infers the key from the alpha channel in a targa 
(.tga) file.
After you save the logo, the logo displays in your LogoCreator 
workspace. To save your logo files using LogoCreator, follow these 
steps:
1. In LogoCreator, open the Logo Set-Up dialog box (Figure 4-4 

below).
When you first open LogoCreator, the Logo Set-Up dialog box 
opens automatically. If the Logo Set-Up dialog box is closed, select 
File > New to open the dialog box.

Figure 4-4. LogoCreator Setup Dialog Box

NOTE

If you click the Open button directly in the Logo Set-Up box, the 
program will only launch files with a .mg2 prefix. If you attempt to 
open a file with any other prefix, the program will generate error 
messages.
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2. Click the Logo button to open the Static Logo dialog box.
3. Use the Logo ID box to assign the logo to a specific slot on your 

IconLogo system. 
4. Enter a name for the logo in the Name box.
5. Click the Open button below the Logo Image Preview window. 

The Open dialog box displays.
6. Select your existing logo file and click the Open button to open the 

logo in the Static Logo dialog box. 

Figure 4-5. Static Logo Dialog Box

• A preview of the composited logo displays in the Logo Image 
Preview area.

• A preview of the image alpha displays in the Logo Alpha 
Preview area if the file contains alpha.

7. Select a file to use as the alpha channel for your logo. 
You must select a file before you can save the logo.
• To use the original image’s alpha channel, select the Use the 

alpha key found with image checkbox.
• To use a different image for the alpha channel, clear the Use the 

alpha key found with image checkbox, and then click the 
Open button to select a new file for your alpha channel.
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NOTE

An alpha channel is an 8-bit layer in a graphics file format that is 
used for expressing translucency (transparency). Typically, you 
define the alpha channel on a per-object basis. Different parts of an 
object will have different levels of transparency depending on how 
much background you want to show through.

8. Click the Save button in the Static Logo dialog box. 
The Save Logo File dialog box opens where you can save your 
logo as a .mg2 file. Once you save the logo as a .mg2 file, the logo 
displays in the LogoCreator workspace.

Figure 4-6. LogoCreator Work Space

Once you create an .mg2 logo you can open the file in LogoCreator, 
set the logo position, and modify specific logo attributes. 
LogoCreator also makes it possible to adjust the noise and strength 
of the key signal and apply fade on/off transitions to the logo.
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Opening and Previewing an Existing .mg2 Logo
To make position, opacity, or key level changes to the .mg2 logo, follow 
these steps:
1. In LogoCreator, select File > Open to open the Open Logo File 

dialog box, or if the Open Logo File dialog box has already 
launched, click Open.

2. Using the Open Logo File dialog box, find and select your .mg2 
logo file.

3. Click the Open button. 
The .mg2 logo displays in the LogoCreator workspace (Figure 4-7).
In the upper left corner (Figure 4-8), you can preview the changes 
you make using the Fill, Opacity, and Logo Position options. 
(Other functions shown in the window are not be supported on the 
XHD-3903.)

Figure 4-7. Opening a Logo
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Figure 4-8. Preview Pane

Modifying the Position, Opacity, and Key Level
Using the Modify button, you can adjust the logo attributes you defined 
when you created the logo.
1. Click the Modify button to open the Logo dialog box, where you 

defined the logo attributes.
2. Use the options to adjust the logo properties.
3. Click Save to save the changes and return to the LogoCreator 

workspace.
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Figure 4-9. Positioning a Logo

To position your logo, either drag the logo to a new position, or use the 
Logo Position X and Logo Position Y boxes below the workspace to 
place your logo in an exact position. You can enter positive or negative 
values. The X value moves the logo horizontally and the Y value moves 
the logo vertically by the set number of pixels. 

NOTE

The Logo Position feature works differently on the XHD-3903 than 
it does on the X75. Using the XHD-3903, the X and Y values that 
you enter or drag (Figure 4-9) will appear in the X Position and Y 
Position parameters in CCS Navigator (see page 96). 

The Opacity sets the overall transparency level for the composited 
logo. Use either the Opacity field or slider to adjust the logo 
transparency. 100% sets the logo as completely opaque. 0% sets the 
logo as completely transparent.

Drag

or change 
position values
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Step 3: Transfer the Logos to the MicroSD Card
When your logos have been created or converted to the .mg2 format, 
they can be saved on the microSD card. The XHD-3903 references files 
on the MicroSD card using the DOS 8.3 short filename convention. 
Longer filenames may be accessed by entering the alternate 8.3 
filename. To avoid any confusion, it is preferable to limit all filenames 
to the 8.3 format, with a maximum of 8 characters before the .mg2 
extension.
In addition, all files must be located within the logos folder on the 
microSD card. Figure 4-10 shows the location of the microSD socket.

Figure 4-10. Inserting the MicroSD Card

Step 4: Set the Parameters and Load the Logo Files 
Using the XHD-3903, you can preset a logo filename and its settings for 
each output standard. The preset logo will automatically load when the 
corresponding output standard is selected and becomes active (Video > 
Output > Output Video Standard Select). You must correctly set the 
Config Select parameter (Video > Processing > Logo) to edit the logo 
preset configuration for a specific output standard.
If you have selected a logo that matches the output standard and the 
logo is available for use, the Load Status parameter will read Loaded. 
Click Enable to activate the logo, or program the logo to be activated 
by GPI settings (see below).
Otherwise, all of the settings that control and monitor the logos are 
found at Video > Processing > Logo. 

MicroSD card in socket
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Table 4-4 lists some typical loading times for various sizes of logos.

Step 5: Make the GPI Settings (Optional) 
As a final step, you may need to set triggers to activate your logos. The 
GPI inputs are internally pulled HIGH. 
In the event that a file has not correctly loaded into the XHD-3903, or it 
has been given the wrong name, Navigator will display an Image Not 
Found major alarm. This alarm will clear itself when the problem is 
resolved. 

Table 4-4. Typical SD Card-to-XHD-3903 Logo Loading Times

Content Format
Approximate Load Time 
from MicroSD Card to 
XHD-3903

Bug logo, 1/16 screen 720p 10 seconds 

Detailed 500 kB image, 1/4 
screen

720p 30 seconds 

Full screen, 8 Mb 1080p 5 minutes
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Navigating the Parameter List
For a complete list of the XHD-3903 parameters, see the separate 
XHD-3903 Parameter List that accompanies this manual.
You can control these parameters in CCS-enabled software and 
hardware devices, and via card-edge controls while viewing the 
on-screen display feature (encoded in the SDI output 2 signal). To 
enable or disable this feature, change the On-Screen Display parameter 
in the Video > Output > Config path. (The default setting is On.) At 
the card-edge, you can enable this feature by holding down the Escape 
button for five seconds.

Navigating the Parameter List at the Card Edge
To navigate, and then view or change a parameter from the Tree View 
using card-edge controls, follow these steps:
1. Using CCS-enabled software, enable the On Screen Display 

parameter.
2. Open the front panel of the NEO frame.
3. Press the Enter button.

The first two items in the Level One list will appear. 
4. Click Nav- (down) on the Nav-/Nav+ switch to view more items in 

the Level One list.
5. Select the desired item in the Level One list, and then press Enter.

This leads you to the Level Two list. 
6. Repeat steps 4 and 5 to view more items in Levels Two, Three, and 

Four. 
7. If the parameter is selectable, slide the bar to the desired parameter 

using the Nav+/Nav-switch, or select the desired item in the Level 
Four list, and then press Enter.

Once the Level Four parameter is set or viewed, you can leave the 
parameter in its current state, or return to the banner. To return to 
the XHD-3903 banner, repeatedly press the Escape button. 
Close the front panel again after you have completed the procedure 
to prevent the frame from overheating. 
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Alarms
The following table lists the alarms for the XHD-3903 modules. You 
can enable or disable these settings (default setting is Disabled), but 
you cannot change the level of the alarms. 

Table 4-5. Default XHD-3903 Alarms 

Alarm Name Alarm 
Level Meaning 

SDI 1 Standard 
Mismatch 

Major The selected and detected primary video signals at the SDI 1 input are 
mismatched.

SDI2 Standard 
Mismatch 

Major The selected and detected primary video signals at the SDI 2 input are 
mismatched.

SDI 1 Loss of Video Major The module detects a loss of video at the SDI 1 input.

SDI 2 Loss of Video Major The module detects a loss of video at the SDI 2 input.

Reference is Invalid Major The reference input is either not valid or not supported.

DARS Not Locked Major The system timing is not locked to the DARS signal.

Scalar Bypass Active Minor The bypass mode is enabled.

Logo File Input/
Output Error

Minor The logo file is not found, not supported, or is corrupted.

Master Mute On Major The master audio mute is enabled.

PCM VBit Mute On Minor The PCM outputs are automatically muted when the V bit is set. 

Teletext Parity Error Minor The teletext input has a parity error.

Teletext Frame Error Minor The teletext input has a frame error.

Dolby Reference 
Mismatch

Major The Dolby signal feeding the decoder is set at a different rate than the video 
reference.

Loss of AFD Major The incoming AFD signal is disrupted.
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Unique State Recovery Behavior
DejaView state recovery of parameters operates differently on the 
XHD-3903 than it does with other NEO products. Unlike most other 
NEO modules, the XHD-3903 does not use a card-edge display. Thus, 
the module does not prompt you to activate DejaView.
Instead, when an a XHD-3903 is inserted in its slot, it is assumed that 
the module will keep its own settings, and it will not download 
DejaView values from the resource module. After five minutes, the 
XHD-3903 module’s values will automatically transfer to the resource 
module.
However, if you insert the XHD-3903 module with the Escape button 
pressed during bootup, LEDs D1-D8 will all flash on, and then off, 
during which time the DejaView settings are transferred from the 
resource module to the new XHD-3903 module. If you remove the 
resource module after DejaView has occurred, and then replace it with 
another resource module, no DejaView activity will occur.
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LEDs and Module Indicators
Each XHD-3903 module has eight card-edge LEDs and four module 
indicators.
The module indicators include Major Alarm and Minor Alarm. These 
alarms alert users to failures or impending failures within the module. 
They are also found in the following locations:
• As red or yellow LEDs on the 3901AIC Alarm Interconnect 

Module or the 3901RES-E Resource Module (visible via light pipes 
through the frame’s front panel)

• In external systems connected to the alarm contact closures at the 
back of the NEO frames

• On CCS-enabled software and hardware devices

Card-Edge Locations

Figure 4-11. Card-Edge LEDs and Module Indicators

Status 
LEDs

Alarm 
LEDs

Power 
indicator

Module
Status indicator
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LED Descriptions
See Figure 4-11 on page 100 for the location of the card-edge LEDs 
described in Table 4-6.

Table 4-6. Color and Meaning of Card-Edge LEDs

LED Color Meaning (When Lit)
SDI In 1 Present Green The module detects the presence of an SDI signal in SDI input 1.

SDI In 1 HD Green The module detects the presence of an HD-SDI signal in SDI input 1 
(SD-SDI input is indicated if the SDI In 1 Present LED is lit while the SDI 
In 1 HD LED is not lit).

SDI In 1 EAUD Green The module detects the presence of embedded audio in SDI input 1.

SDI In 2 Present Green The module detects the presence of an SDI signal in SDI input 2.

SDI In 2 HD Green The module detects the presence of an HD-SDI signal in SDI input 2 
(SD-SDI input is indicated if the SDI In 1 Present LED is lit while the SDI 
In 1 HD LED is not lit).

SDI In 2 EAUD Green The module detects the presence of embedded audio in SDI input 2.

Ref In Green The module is locked to an external reference signal.

DARS In Green The module detects DARS input.
(If the LED flashes, DARS input is present but not locked; if the LED is lit 
but not flashing, the DARS input is present and locked.) 
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Module Indicator Descriptions
See Figure 4-11 on page 100 for the location of the module indicators 
described in Table 4-7.

Table 4-7. Color Meaning of Module Indicators

Module 
Indicator Color Meaning (When Lit)

Major Alarm
(see Table 4-5 
on page 98 for 
details)

Red The module detects one or more of the 
following problems: 
• Mismatch between the selected and 

detected primary video signal
• Mismatch between the selected and 

detected secondary video signal
• Loss of SDI 1 input video
• Loss of SDI 2 input video
• Loss of locked reference
• Loss of DARS reference
• Master audio muted

Minor Alarm
(see Table 4-5 
on page 98 for 
details)

Yellow The module detects one or more of the 
following problems: 
• PCM VBit Mute is enabled.
• Parity error in thee teletext signal 
• Frame error in the teletext signal 

Power Green The module is receiving power.

Module Status Green The module is configured, loaded, and 
operational.
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Specifications

Overview
The tables in this chapter list the following specifications for the 
XHD-3903 modules: 
• “Inputs” on page 104
• “Outputs” on page 107
• “Propagation Delays” on page 109
• “Miscellaneous” on page 110
Some of the connectors described in this chapter are found on the 
breakout cables supplied for the back module.

Specifications and designs are subject to change without notice.
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Inputs

SD-SDI Video (270 Mb/sec)

HD-SDI Video (1.5 Gb/sec)

Table 5-1. SD-SDI Video (270M) Specifications

Item Specification
Standard SMPTE 259M-C, 270 Mbps, 525/625 component

Connector BNC (IEC 169-8)

Impedance 75Ω 

Return loss >18 dB from 5 MHz to 270 MHz

Equalization >23 dB Belden 8281 cable

Table 5-2. HD-SDI Video (1.5 G) Specifications

Item Specification
Standard SMPTE292M, 1080i/59.94, 1080i/50, 720p/59.94, 

720p/50, 1080p/23.98, 720p/23.98

Connector BNC (IEC169-8)

Impedance 75Ω 

Return loss >18 dB (typical) from 5 MHz to 1485 MHz

Equalization • Adaptive cable equalization for up to 492 ft 
(150 m), typical, of Belden 1694A coaxial cable 
(Hardware Version A*)

• Adaptive cable equalization for up to 656 ft 
(200 m) typical, of Belden 1694A co-axial cable 
(Hardware Version B or later*)

* See Parameters > Other to obtain hardware 
information about your model
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HD-SDI Video (3 Gb/sec)

AES/DARS (Balanced)

Table 5-3. HD-SDI Video (3 G) Specifications

Item Specification
Standard SMPTE 424M, SMPTE 372M (4:2:2 10-bit)

Connector BNC (IEC 169-8)

Impedance 75Ω 

Return loss • >15 dB, typical, from 5 MHz to 1485 MHz
• >10 dB, typical, from 1485MHz to 2970MHz

Equalization • Adaptive cable equalization for up to 164 ft 
(50m) , typical, of Belden 1694A coaxial cable 
(Hardware Revision A*)

• Adaptive cable equalization for up to 427 ft 
(130 m), typical, of Belden 1694A co-axial cable 
(Hardware Revision B* or later)

* See Parameters > Other to obtain hardware 
information about your model

Table 5-4. AES/DARS (Balanced) Specifications

Item Specification
Number of inputs 8 + DARS

Standard AES3

Connector XLR

Sensitivity <200 mV pk-to-pk (100 mV pk-to-pk typical)

Impedance 110 ±20% (0.1 MHz to 6 MHz)

Common mode 
rejection

0 V to 7 V (0 kHz to 20 kHz)

Input audio rate 16 kHz to 96 kHz
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AES/DARS (Unbalanced)

Genlock

Table 5-5. AES/DARS (Unbalanced) Specifications

Item Specification
Number of inputs 8 + DARS

Standard AES3, SMPTE276M

Connector BNC (IEC169-8)

Sensitivity <100 mV pk-to-pk (50 mV pk-to-pk typical)

Impedance 75Ω 

Return loss <-25 dB, 0.1 MHz to 6 MHz (<-35 dB typical)

Input audio rate 16 kHz to 96 kHz

Table 5-6. Genlock Specifications

Item Specification
Connector BNC (IEC169-8)

Return loss • >40 dB (typical) to 6 MHz
• >35 dB (typical) to 30 MHz

Input level • 1 V pk-to-pk, -5.0 dB to + 6.0 dB for NTSC/
PAL-B

• 1 V pk-to-pk, -3.5 dB to + 6.0 dB for tri-level 
sync
• 1080i: 59.94/50
• 1080p: 29.97/25
• 720p: 59.94 *

Signal type • NTSC/PAL-B analog composite
• ±300 mV Tri-level sync 

• 1080i: 59.94/50
• 1080p: 29.97/25
• 720p: 59.94 *

* 720p/59.94 reference is accepted only at 720p/59.94, 1080p/59.94, or 1080p/59.94 Level B output
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Outputs
SD-SDI Video (270 Mb/sec)

HD-SDI Video (1.5 Gb/sec)

Table 5-7. SD-SDI Video (270M) Specifications

Item Specification
Standard SMPTE 259M-C, 270Mbps, 525/625 component

Quantization 10 bits

Connector BNC (IEC 169-8)

Impedance 75Ω 

Return loss 18 dB (typical) from 5 MHz to 270 MHz

Signal level 800 mV ±10%

D.C. offset 0.0 V ±0.5 V

Rise and fall time 400 ps to 1500 ps (20% to 80%)

Overshoot <10% of amplitude

Jitter Timing: <0.2 UI; alignment: <0.2 UI

Table 5-8. HD-SDI Video (1.5) Specifications

Item Specification
Standard SMPTE292M

Quantization 10 bits

Connector BNC (IEC 169-8)

Impedance 75Ω 

Return loss 18 dB (typical) from 5 MHz to 1485 MHz

Signal level 800 mV ±10%

D.C. offset 0.0 V ±0.5 V

Rise and fall time <270 ps

Overshoot <10% of amplitude

Jitter Timing: <1 UI; alignment: <0.2 UI
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HD-SDI Video (3 Gb/sec)

AES (Balanced)

Table 5-9. HD-SDI Video (3 G) Specifications

Item Specification
Standard SMPTE 424M, SMPTE 372M (4:2:2 10-bit)

Quantization 10 bits

Connector BNC (IEC 169-8)

Impedance 75Ω 

Return loss • 12 dB (typical) from 5 MHz to 1485 MHz
• 12 dB (typical) from 1485 MHz to 2970 MHz

Signal level 800 mV ±10%

D.C. offset 0.0 V ± 0.5 V

Rise and fall time <135 ps (20/80), no differ by more than 50 ps

Overshoot <10% of amplitude

Jitter • Timing jitter: 2 UI
• Alignment jitter: 0.3 UI

Table 5-10. AES/DARS (Balanced) Specifications

Item Specification
Number of outputs 8

Standard AES3

Connector XLR

Impedance 110 ±20% (0.1 MHz to 6 MHz)

Jitter <±4 ns, peak value

DC offset 0.0 ±50 mV

Rise/fall time 5 ns to 30 ns (10% to 90%) (10 ns typical)
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AES (Unbalanced)

Propagation Delays
See page 83 for detailed propagation delay information.

Table 5-11. AES/DARS (Unbalanced) Specifications

Item Specification
Number of outputs 8

Standard AES3, SMPTE276M

Connector BNC (IEC169-8)

Impedance 75Ω 

Return loss <-25 dB, 0.1 MHz to 6 MHz (<-35 dB typical)

Jitter <±4 ns, peak value

DC offset 0.0 ± 50 mV

Rise/fall time 30 ns to 44 ns (10% to 90%) (33 ns typical)
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Miscellaneous

RS-232/RS-422/485

Power Consumption

GPI Input/Output

Table 5-12. RS-232/RS-422/485 Specifications

Item Specification
Electrical Differential balanced

Standard Electrical specification EIA-232C

Connector • DB-9
• 232/422/485 switchable 
• 422/485 termination can be selected

Table 5-13. Power Consumption Specifications

Item Specification
Maximum power 
consumption

• 24 W for non-AES version
• 26 W for AES version

Power supply 24 V

Table 5-14. GPI Input/Output Specifications

Item Specification
GPI inputs • Number: 4

• Internally pulled HIGH
• External contact closure to ground to trigger

GPI outputs • Number: 4
• TTL compatible
• 5 mA drive

Connector DB-9
110 XHD-3903 Installation and Operation Manual



  
Appendix A

Audio Bit Manipulation

Overview
This appendix contains information on the manipulation of bits that 
occur when using the XHD-3903 modules.
RX Key: N = not recognized, Y = recognized, S = recognized and 
stored or passed through or both
TX Key: N = not transmitted, Y = transmitted
XHD-3903 Installation and Operation Manual 111



  
 Appendix A: Audio Bit Manipulation
Channel Status Bits
Table A-1. C-Bit Manipulation 

Byte Bit Function RX TX Remarks
0 0 [0] Consumer use

[1] Professional use
N
Y

N
Y

Set to [1]

0 1 [0] Normal Audio Mode (linear PCM)
[1] Non-audio (non-PCM)

S
S

Y
Y

Passed unmodified

0 2 to 4 [000] Not indicated
[100] No emphasis
[110] 50/15 µs
[111] CCITT J.17

S
S
S
S

Y
Y
Y
Y

Passed unmodified

0 5 [0] Locked
[1] Unlocked

N
N

Y
N

Set to [0]

0 6 to 7 [00] Not indicated
[01] 48 kHz
[10] 44.1 kHz
[11] 32 kHz

Y
Y
Y
Y

N
Y
N
N

Set to [01]

1 0 to 3 [0000] Not indicated
[0001] Two channel
[0010] Mono
[0011] Prim/sec
[0100] Stereo
[0101] to [1111] Undefined

N
N
N
N
N
N

Y
N
N
N
N
N

Set to [0000]

1 4 to 7 [0000] Not indicated
[0001] 192 bit block
[0010] AES18 (HDLC)
[0011] User defined
[0100] to [1111] Undefined

N
N
N
N
N

Y
Y
Y
Y
Y

Set to [0000]

2 0 to 2 [000] Not indicated
[001] Audio data
[010] Co-ordination signal
[011] to [111] Undefined

N
N
N
N

N
Y
N
N

Set to [001] 
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2 3 to 5 [000] Not indicated
[001] Max length - 1
[010] Max length - 2
[011] Max length - 3
[100] Max length - 4
[101] Max length
[110] to [111] Undefined

N
N
N
N
N
N
N

N
N
N
N
N
Y
N

Set to [101]

2 6 to 7 Reserved N Y Set to [0]

3 0 to 7 Reserved N Y Set to [0]

4 0 to 1 [00] Not a reference 
[01] Grade 1 reference
[10] Grade 2 reference
[11] Undefined

N
N
N
N

Y
N
N
N

Set to [00]

4 2 Reserved N Y Set to [0]

4 3 to 6 [0000] Not indicated
[1000] 24 kHz
[0100] 96 kHz
[1100] 192 kHz
[1100] 22.05 kHz
[0101] 88.2 kHz
[1101] 176.4 kHz
[1111] User defined

N
N
N
N
N
N
N
N

Y
N
N
N
N
N
N
N

Set to [0000]

4 7 [0] Sample frequency not scaled
[1] Sample frequency scaled by 1/1.001

N
N

Y
N

Set to [0]

5 0 to 7 Reserved N Y Set to [0]

6 to 9 0 to 7 Alphanumeric channel origin data S Y Passed unmodified

10 to 13 0 to 7 Alphanumeric channel destination data S Y Passed unmodified

14 to 17 0 to 7 Local sample address code S Y Passed unmodified

18 to 21 0 to 7 Time-of-day sample address code S Y Passed unmodified

22 0 to 3 Reserved N Y Set to 0

22 4 Bytes 0 to 5 reliability flag S Y Passed unmodified

22 5 Bytes 6 to 13 reliability flag S Y Passed unmodified

Table A-1. C-Bit Manipulation (Continued)

Byte Bit Function RX TX Remarks
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Validity and User Bits

Miscellaneous Data

22 6 Bytes 14 to 17 reliability flag S Y Passed unmodified

22 7 Bytes 18 to 21 reliability flag S Y Passed unmodified

23 0 to 7 CRC Y Y Calculated on output

Table A-1. C-Bit Manipulation (Continued)

Byte Bit Function RX TX Remarks

Table A-2. V-Bit and U-Bit Manipulation

Bit Manipulation RX TX Remarks
Validity (V) bit S Y Passed unmodified

User (U) bit S Y Passed unmodified

Table A-3. Miscellaneous Data

Item RX Specification TX Specification
Audio sampling 
frequency 

32 to 108 kHz 48 kHz

Audio sampling word 
length

16 to 24 bits 24 bits
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Advanced Audio Packages

Overview
This chapter describes the different advanced audio option packages 
that are available with the XHD-3903. The following topics are 
covered:
• “Dolby and DTS Neural Audio Licenses” on page 116
• “Block Diagrams” on page 118
• “Hardware and Software Installation” on page 122
• “Dolby Audio Metadata” on page 124
• “Audio Delay with Advanced Audio Modules” on page 124
• “DTS Neural Audio Parameters” on page 126
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Dolby and DTS Neural Audio Licenses
The XHD-3903 offers a wide variety of Dolby and DTS Neural audio 
processing options, either as separate licenses, or in different 
combinations (Dolby-2 and Dolby-3 options require version 4.0.4 
firmware on the frame’s resource module).
These options make it possible to offer advanced audio processing for 
high-definition and surround sound programming using 5.1 and stereo 
sources.
To install one of these audio options, your XHD-3903 module must be 
configured for AES capability. This may require the installation of the 
XHD3903-UG-AESC upgrade kit.
Figure B-1 shows how DTS Neural and Dolby audio processing is 
integrated into the XHD-3903 signal flow. Table B-1 on page 117 lists 
the different audio license keys available.

NOTE

Only one Dolby or DTS Neural license may be purchased for each 
XHD-3903 module.

Figure B-1. XHD-3903 Signal Flow with Neural Audio 
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Table B-1. Neural Audio License Keys

Part Number Capability
XHD3903OPT-D1 Dolby E and AC-3 Decoder Option Hardware and Software key (AES input/output version 

required; for field upgrade, order XHD3903-UG-AESC)

XHD3903OPT-D2 Dolby E Integrated Encoder Hardware and Software Key (AES input/output version required; 
for field upgrade, order XHD3903-UG-AESC)

XHD3903OPT-D3 Dolby Digital (AC-3) Integrated Encoder Hardware and Software Key (AES input/output 
version required; for field upgrade, order XHD3903-UG-AESC)

XHD39OPT-DM DTS Neural Surround™ DownMix DTV 5.1 Transport Solution, plug-in for NEO XHD-3903 
(AES input/output version required; for field upgrade, order XHD3903-UG-AESC)

XHD39OPT-DM-LC DTS Neural Surround™ DownMix DTV 5.1 Transport Solution with NLC Neural Loudness 
Control, plug-in for NEO XHD-3903 (AES input/output version required; for field upgrade, 
order XHD3903-UG-AESC)

XHD39OPT-LC DTS Neural Loudness Control for 2.0 or 5.1 Program Audio, plug-in for NEO XHD-3903 (AES 
input/output version required; for field upgrade, order XHD3903-UG-AESC)

XHD39OPT-LC-6+2 DTS Neural Loudness Control for 2.0 and 5.1 (separate programs), plug-in for NEO XHD-3903 
(AES input/output version required; for field upgrade, order XHD3903-UG-AESC)

XHD39OPT-LC-8 DTS Neural Loudness Control for 4 x 2.0 Program Audio, plug-in for NEO XHD-3903 (AES 
input/output version required; for field upgrade, order XHD3903-UG-AESC)

XHD39OPT-LC+DM DTS Neural Loudness Control for 5.1 Program Audio with Neural DTS-Surround™ Downmix 
output, plug-in for NEO XHD-3903 (AES input/output version required; for field upgrade, 
order XHD3903-UG-AESC) 

XHD39OPT-MM DTS Neural Surround™ 5.1 and rendered stereo content transitioning for DTV 5.1 Production, 
plug-in for NEO XHD-3903 (AES input/output version required; for field upgrade, order 
XHD3903-UG-AESC)

XHD39OPT-MM-LC DTS Neural Surround™ 5.1 and rendered stereo content transitioning for DTV 5.1 Production 
with NLC Neural Loudness Control, plug-in for NEO XHD-3903 (AES input/output version 
required; for field upgrade, order XHD3903-UG-AESC)

XHD39OPT-UM DTS Neural Surround™ UpMix DTV 5.1 Production Solution, plug-in for NEO XHD-3903 
(AES input/output version required; for field upgrade, order XHD3903-UG-AESC)

XHD39OPT-UM-LC DTS Neural Surround™ UpMix DTV 5.1 Production Solution with NLC Neural Loudness 
Control, plug-in for NEO XHD-3903 (AES input/output version required; for field upgrade, 
order XHD3903-UG-AESC)
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Block Diagrams

Dolby
Figure B-2 shows how Dolby is used in a typical XHD-3903 
application. Dolby E or Dolby Digital (AC-3) decoding takes place at 
ingest for voice-over.

NOTE

Only one Dolby or DTS Neural license may be purchased for each 
XHD-3903 module.

Figure B-2. Dolby Block Diagrams
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DTS Neural
The block diagrams shown in Figure B-3 to Figure B-5 illustrate the 
uses of the different DTS Neural audio license key options. 

Figure B-3. DTS Neural Audio Option Block Diagrams (1)
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Figure B-4. DTS Neural Audio Option Block Diagrams (2)
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Figure B-5. DTS Neural Audio Option Block Diagrams (3)
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Hardware and Software Installation
The Dolby and DTS Neural packages consist of two parts:
• Hardware submodule 
• Software keycode to enable the submodule

Follow these steps to install the hardware:
1. Remove the XHD-3903 module from its frame.
2. Gently insert the connector side of the submodule into the Dolby/

DTS Neural socket of the XHD-3903 module (see Figure B-6).

Figure B-6. Inserting Submodule into Socket

3. Press the submodule edges down slowly until it locks into place 
(see Figure B-7 and Figure B-8).

Figure B-7. Submodule Installed
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Figure B-8. Submodule Locked in Place

4. Reinsert and power up the XHD-3903 module.

Follow these steps to install an advanced audio license key:
1. Enter the license key number in the Other > License Key field, and 

then press Enter on your keyboard.
2. Wait 30 seconds for the change to take effect.
3. Reboot the module by removing it from the frame or by starting the 

reboot procedure in CCS Navigator.
The module may take a moment before it is enabled for use.

4. Confirm the license key type by rolling over the Other > Options 
field. 

NOTE

An XHD-3903 with a DTS Neural module installed will display 
different LEDs during software upgrades. See page 34 for details.
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Dolby Audio Metadata
When the Dolby decoder option is in use, you can source audio 
metadata from the external serial port, SDI demux, or from the Dolby 
decoder. The audio metadata can then be embedded in the output video.
To select the source of the metadata, use the Ameta Source parameter 
(Audio > Output > Embedder). The Ameta Present parameter 
indicates when the metadata is detected.
When you apply external metadata to the XHD-3903, the metadata 
properties persist even after you remove the external metadata from the 
module. Performing a Factory Default of the user settings does not 
clear the metadata properties that were received when external metadata 
was present. After you remove the external metadata, you must restart 
the module to clear the metadata properties.
For general information about the use of audio metadata in professional 
video applications, visit the Dolby Web site at www.dolby.com.

Audio Delay with Advanced Audio Modules
When a Dolby or DTS Neural advanced audio module is enabled, an 
additional system delay is applied automatically to all other audio 
routing, ensuring all audio outputs are aligned (the automatic delay is 
the same as the processing delay of non-Dolby/Neural audio).
However, there is only one delay applied per audio input source. 
Therefore, if the input source is routed through the advanced audio 
module and then that source is concurrently routed to an output, the two 
outputs will be misaligned.
The advanced audio feature also includes Audio Latency and Video 
Latency parameters. Audio latency is the total audio latency through 
the system, and does not include any additional user delay. Video 
latency refers to the total video latency through the system from the 
input to the output. If the two values do not match (possibly because an 
advanced audio processing module is adding audio delay), select Track 
Audio to add a one-time minimum number of input frames of delay to 
synchronize the video and audio.
124 XHD-3903 Installation and Operation Manual

http://dolby.com


 Appendix B: Advanced Audio Packages

  
If the Input Frame Delay is later modified, you can trigger the Track 
Audio parameter to add back the minimum number of frames to the 
Input Frame Delay parameter to compensate for these delays. (Both 
parameters are in Video > Processing > Synchronizer: Ch1). If there 
is no Neural module installed, the Track Audio control is always 
disabled (and audio should always be aligned). 
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DTS Neural Audio Parameters
Each DTS Neural module has its own specific parameters:
• The XHD39OPT-UM+ and XHD39OPT-UM+LC+ include the 

UpMix parameters listed in Table  on page 127. 
• The XHD39OPT-DM+, XHD39OPT-DM+LC+, and 

XHD39OPT-LC+DM+ include the DownMix parameters listed in 
Table B-3 on page 130.

• The XHD39OPT-MM+ and XHD39OPT-MM+LC+ include the 
MultiMerge parameters listed in Table B-4 on page 132. 

• The XHD39OPT-LC+6+2+, XHD39OPT-LC+8+, 
XHD39OPT-LC+DM+, XHD39OPT-UM+LC+, 
XHD39OPT-DM+LC+, and XHD39OPT-MM+LC+ include the 
Loudness Control parameters listed in Table B-6 on page 137.

General Steps for Routing DTS Neural Audio
Follow these general steps when configuring DTS Neural products:
1. Determine the input sources for the DTS Neural module (either 

AES or demuxed audio).
2. Route the inputs intended for DTS Neural processing to a set of 

SRCs (sample rate convertors) by following Audio > Input > 
Routing > SRCx Input Select.
(SRCs 1 to 4 will be used, each being fed a stereo pair.) 

3. Route the designated input SRCs to DTS Neural module inputs by 
following Audio > Input > Routing > AdvAudio/Dlby Ch1-8.
These parameters assign the output of the SRCs that you selected in 
step 2. The output of these SRCs will then feed the DTS Neural 
module inputs. 

4. Route the DTS Neural audio outputs to the SRC by assigning each 
output of the DTS Neural processing to the input of an SRC, under 
Audio > Input > Routing > (unused SRCx Input Select > 
AvAudProcChx/y).

5. Route the designated output SRCs (sample rate convertors) to 
system outputs by following Audio > Output > Routing, selecting 
the output SRCs from step 4 to feed either a mux channel or AES 
output.
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DTS Neural Audio UpMix 
Overview

The DTS Neural Surround UpMix renders any two channel audio 
source (stereo, matrix encoded stereo, LtRt, or DTS Neural Surround 
LwRw) as surround sound. The DTS Neural Surround UpMix can 
simultaneously position individual elements within the surround field, 
creating high levels of image stability and granularity. 
The UpMix technology avoids taking “artistic license” with content by 
placing audio exactly where it would be heard in a professional LEDE 
(Live End Dead End) listening environment. For example, mono or 
pan-pot stereo will image in front of the listener, whereas stereo 
containing depth information will surround the listener. 
You can use the DTS Neural Surround UpMix as a stand-alone unit to 
monitor stereo production, or you can use it in tandem with the DTS 
Neural Surround DownMix as a complete 5.1 transport solution. 
Figure B-9 below shows an UpMix taking a two-channel audio source 
(stereo, matrix encoded stereo, LtRt or DTS Neural Surround LwRw) 
and rendering a 5.1 multi-channel mix. 

Figure B-9. UpMix Block Diagram 
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Parameters

Table B-2. DTS Neural Audio UpMix Parameters 

Processing > Neural > Upmix
Parameter Name Function Options

Output Config Controls the output channel configuration generated by the 
Upmix. 

• 2.1
• 3.1
• 4.1
• 5.1 

Output Bias Controls the soundstage depth of the upmix. 
(Values near -1.0 indicate that the soundstage image will be 
biased toward the surround channels; values near 1.0 
indicate that the soundstage image will be biased toward the 
front channels)

-1.00 to 1.00 (0)

Upmix LFE Mute Mutes the LFE channel output from the upmix • Yes
• No 

LFE Up Cutoff Controls the cutoff frequency of the low pass filter applied 
to the LFE channel before output 

60 Hz to 140 Hz 
(80 Hz) 

Limiter Enable Enables a limiter on the surround output from the upmix • No
• Yes 

Limiter Threshold Sets the upper threshold of the limiter applied to the output -20 dBFS to 0 dBFS 
128 XHD-3903 Installation and Operation Manual



 Appendix B: Advanced Audio Packages

  
DTS Neural Audio DownMix 
Overview

The DTS Neural Surround DownMix enables 5.1 surround sound to be 
transported through any stereo infrastructure. The downmix process is 
based upon the principle that both natural stereo and 5.1 content are 
two-dimensional; both contain width and depth spatial attributes. 
The DTS Neural Surround DownMix can represent six channels of 
discreet audio sources in a stereo downmix by transforming the sources 
into pure intensity and coherence encoding. By correcting overlaps of 
the signal sources in intensity, time, coherence, polarity, and phase 
before the six channels are combined, the DTS Neural Surround 
DownMix accounts for the problems suffered in traditional matrix 
encode systems—such as comb filtering, spatial location distortion, etc. 
The proprietary Neural Audio “watermark process” faithfully 
reproduces surround information when it is rendered by the DTS Neural 
Surround UpMix or any LtRt system. In brief, the DTS Neural 
Surround DownMix produces a stereo downmix that accurately 
represents the original content whether monitored in mono, stereo, 
matrix or DTS Neural 5.1 Surround Sound. 
Figure B-10 below shows a DownMix taking a multi-channel audio 
source. The downmix creates two-channel audio source using the 
Neural Audio approach of embedding a watermark signal within the 
stereo audio signal patch. The watermark signal contains spatial and 
steering positioning information. The resulting stereo audio signal is 
also known as LwRw. 

Figure B-10. DownMix Block Diagram 
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Parameters

Table B-3. DTS Neural Audio DownMix Parameters

Processing > Neural > Downmix
Parameter Name Function Options

LFE Down Filter En Enables a low pass filter to the LFE input to 
the downmix

• No
• Yes 

LFE Down Cutoff Sets the cutoff frequency of the low pass 
filter applied to the LFE input

60 Hz to 140 Hz (80 Hz) 

Limiter Enable Enables a limiter on the stereo output of the 
downmix

Note: 6 (5.1) channels of audio can naturally 
represent more total energy than 2 (stereo) 
channels of audio. Because of this, content 
downmixed from 5.1 to stereo will often have 
higher energy than any of the 5.1 channels 
individually. You can enable the limiter to 
protect content from digital 0 clipping and adjust 
the desired threshold.

• No
• Yes 

Limiter Threshold Sets the upper threshold of the limiter 
applied to the output

-20 dBFS to 0 dBFS
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DTS Neural Audio MultiMerge 
Overview

The DTS Neural Surround MultiMerge enables broadcasters to 
transition from stereo to 5.1 surround sound, providing viewers with a 
24/7 surround sound experience. With MultiMerge inline, 5.1 original 
content is passed unaffected to the viewer while original stereo content 
is upmixed to a 5.1 surround sound image. This provides the viewer 
with a consistent surround experience. 
The transition between 5.1 and stereo occurs seamlessly without the 
need of operator intervention. By offering a 24/7 5.1 signal, AC3 
metadata does not transition between 2/0 and 3/2 mode. This prevents 
audio clicks, pops, and dropouts. The process also avoids taking 
“artistic license” with content by placing audio exactly where it would 
be heard in a professional LEDE (Live End Dead End) listening 
environment. For example, mono or pan-pot stereo will image in front 
of the listener, whereas stereo containing depth information, or LtRt 
encoding, will surround the listener. 
You can use the MultiMerge in combination with the DTS Neural 
Surround DownMix device to pass 5.1 through stereo-only facilities 
and therefore eliminate the need for costly master control upgrades.
Figure B-11 shows how the MultiMerge takes a two-channel audio 
source (stereo, matrix encoded stereo, LtRt or DTS Neural Surround 
LwRw) and render a 5.1 multi-channel mix; in combination with taking 
original multi-channel content and creating a stereo downmixed signal, 
depending on the input configuration and content source used.

Figure B-11. MultiMerge Block Diagram 
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Table B-4. DTS Neural Audio MultiMerge Parameters 

Processing > Neural > Multimerge 
Parameter Name Function Options

Input Selection Mode Selects the input selection mode
(See Table B-5 on page 133 for descriptions 
of these options.)

• Mix 
• Multi
• Stereo
• Aux
• Multi Detect
• Stereo Detect
• Aux Detect
• Multi Aux Stereo 

Multimerge Mode Controls the mode of the MultiMerge 
algorithm

• Auto 
• Pass Through
• Up Mix

Detect Threshold Controls the noise floor level for the detection 
while in Auto mode. 

80 dBFS to -50 dBFS (-60 dBFS) 

Input Crossfade Time Determines the transition time from one 
source to another

50 ms to 750 ms (200 ms)

MM Crossfade Time Controls the length of the audio crossfade 
used on the outputs when switching between 
Upmix and Passthrough modes automatically

50 ms to 750 ms (200 ms) 

Upmix LFE Mute Mutes the LFE channel output from the upmix • Yes
• No 

LFE Up Cutoff Controls the cutoff frequency of the low pass 
filter applied to the LFE channel before output

60 Hz to 140 Hz (80 Hz) 

LFE Down Filter En Enables a low pass filter to the LFE input to 
the downmix

• No
• Yes 

LFE Down Cutoff Sets the cutoff frequency of the low pass filter 
applied to the LFE input

60 Hz to 140 Hz (80 Hz) 

Surround Limiter En Enables a limiter on the surround output from 
the multimerge

• No 
• Yes 
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Parameter Name Function Options

Surround Threshold Sets the upper threshold of the limiter applied 
to the surround output

-20 dBFS to 0 dBFS

Stereo Limiter en Enables a limiter on the stereo output of the 
multimerge

• No
• Yes 

Stereo Threshold Sets the upper threshold of the limiter applied 
to the stereo output

-20 dBFS to 0 dBFS

Table B-4. DTS Neural Audio MultiMerge Parameters (Continued)

Table B-5. Input Selection Mode Option Descriptions 

Option Notes
Mix • This option sums the Aux input to the L/R of the 5.1 input.

• The AES1, AES2, AES3 inputs are 5.1 (L/R, C/LFE, Ls/Rs) in.
• The AES4 input is 2.0 in (L/R) in.
• The AES1 output is a sum of AES 1 and AES 4 (AES1L + AES4L, AES1R + AES4R).
• The AES2 output is C/LFE.
• The AES3 output is LsRs.

Multi • This option only sources audio from the 5.1 input.
• Inputs are AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs).
• Outputs are AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs).
• AES4 is not used

Stereo • Audio is sourced from only the L/R pair, while simultaneously muting the C/LFE and Ls/
Rs pairs of the 5.1 input (used in situations where there is information on the other inputs 
that you would want to ignore).

• Input is AES1 (L/R)
• Output is AES1 (L/R)
• AES2, AES3, AES4 are not used

Aux • This option only sources audio from the Aux input.
• Input is AES4 (L/R).
• Output is AES4 (L/R).
• AES1, AES2, AES3 is not used
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Multi Direct • If audio is present on the 5.1 input, the Aux input is overridden.
• Inputs are 2.0 on AES1 (L/R) or 5.1 on AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs) or 2.0 

on AES4 (L/R).
• Outputs are 5.1 on AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs) and 2.0 on AES4 (L/R)

Stereo Detect If audio is present on the L/R pair of the 5.1 input, the Aux input is overridden. Information 
on the C/LFE and Ls/Rs pairs of the 5.1 input is ignored.

Aux Detect • If audio is present on the Aux input, the 5.1 input is overridden.
• This is an EAS application mode.
• Inputs are 5.1 on AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs), and EAS input on AES4 

(L/R).
• Output is 5.1 on AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs).
• When EAS appears on AES4 input, the output becomes EAS output on AES1 (L/R).

Multi Aux 
Stereo

• If audio is present on the 5.1 input, the Aux input is overridden. 
• If only L/R is present on the 5.1 input and audio is present on the Aux, the L/R is 

overridden. 
• If there is no audio present on C/LFE, Ls/Rs, or Aux inputs, source from L/R.

• If 5.1 is present, take 5.1.
• If there is no 5.1 or stereo available on either L/R or AUX, take AUX.
• If stereo is only available on L/R, take L/R.

Table B-5. Input Selection Mode Option Descriptions (Continued)

Option Notes

MultiMerge 
Input

Scenario 1 
(5.1)

Scenario 2 
(Lt/Rt) Scenario 3

AES 1 L/R Yes Yes (foreign 
language)

Yes (foreign 
language)

AES 2 C/LFE Yes No No

AES 3 LS/RS Yes No No

AES 4 Aux No Yes (desired 
language)

No
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DTS Neural Loudness Control 
Overview

DTS Neural Loudness Control is a loudness leveling device that uses 
advanced psycho-acoustic and signal processing techniques to 
accurately detect and regulate the perceived loudness of stereo and 5.1 
sources. Using this feature, you can regulate audio without creating the 
perception of being “squished” or compressed. 
One of the important aspects of loudness control is frequency 
compensation. Loudness studies dating back to Fletcher /Munson in the 
1930s found that the human ear is more sensitive to different 
frequencies at different loudness levels. The Frequency 
Compensation parameter preserves the same perceptual frequency 
balance as the input signal, while correcting the loudness to match a 
desired Target Level. 
For example, with Frequency Compensation enabled at a medium 
level, signals that fall below the Target Level setting have more gain 
added to middle frequencies than higher or lower frequencies. This 
preserves the original spectral balance. Conversely, signals that fall 
above the Target Level setting will have middle frequencies attenuated 
more than higher or lower frequencies. Because the Frequency 
Compensation parameter applies less gain to high and low frequencies, 
high or low frequency noise does not become over-emphasized.
The DTS Neural Loudness Control processing library is written in 
standard floating point ANSI C code, with a simple and straightforward 
API (application programming interface). The processing operates on 
separate mono buffers of floating point multichannel sources. In other 
words, a frame of audio samples for each channel L, R, C, LFE, Ls, and 
Rs is passed to the loudness control process. The loudness control 
engine outputs a frame of processed audio samples for each of the 5.1 
output channels L, R, C, LFE, Ls, and Rs.
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Figure B-12. Loudness Control Block Diagram

Parameters
Table B-6 on page 137 lists the parameters for the various DTS Neural 
Loudness Control options.

NOTE

Group 1 parameters in the XHD39OPT-LC+6+2+ modules are 
repeated again for Group 2. In XHD39OPT-LC+8+ modules, these 
parameters appear for Groups 1, 2, 3, and 4.
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Table B-6. DTS Neural Audio Loudness Control Parameters

Processing > Neural > Loudness Control
Parameter Name Function Options

Preset Select Selects a loudness control preset • (select preset) 
• Mild
• Medium
• Aggressive 

Processing > Neural > Loudness Control > Group 1 
Processing > Neural > Loudness Control > Group 2 (XHD39OPT-LC+6+2+ and 
XHD39OPT-LC+8+ only)
Processing > Neural > Loudness Control > Group 3 (XHD39OPT-LC+8+ only)
Processing > Neural > Loudness Control > Group 4 (XHD39OPT-LC+8+ only)

Bypass Loudness Control bypass • LC1 enable 
• LC1 bypass 

Target Level Loudness Control Target Level -31 dBFS to -1 dBFS (-27 dBFS) 

LC Ratio Loudness Control Ratio 0.00 to 1.00 (0.95) 

Upper Threshold Loudness Control Upper Threshold 0 dB to 12 dB (0 dB)

Lower Threshold Loudness Control lower threshold -12 dB to 0 dB (0 dB)

Freeze Window Loudness Control freeze window 0.0 to 6.0 (1.0) 

Noise Floor Loudness Control Noise Floor -60 dBFS to -40 dBFS 
(-50 dBFS) 

Attack Time Loudness Control Attack Time 0 ms to 120 ms (20 ms) 

Release Time Loudness Control Release Time 40 ms to 200 ms (120 ms) 

Freq Compensation Sets the reference level relative to the loudness 
shaping 

• Off
• Low 
• Medium
• High 

Parameter Name Function Options

Compressor Threshold Sets the threshold at which short term peaks are 
accepted

0 dB to 12 dB (5 dB

Compressor Ratio Loudness Control Compressor Ratio 0.0 to 1.0 (0.4) 

Output Limiter En Loudness Control Output Limiter Enable • No
• Yes 

Output Limiter Threshold Loudness Control Output Limiter Threshold -20 dBFS to 0 dBFS 
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